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Copyright and Trademarks

No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any
means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko
Epson Corporation. No patent liability is assumed with respect to the use of the information contained herein. Neither
is any liability assumed for damages resulting from the use of the information herein. The information contained
herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as
applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for
damages, losses, costs, or expenses incurred by the purchaser or third parties as a result of accident, misuse, or abuse of
this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to
strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation and its affiliates shall not be liable for any damages or problems arising from the use of any
options or any consumable products other than those designated as Original Epson Products or Epson Approved
Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic interference that
occurs from the use of any interface cables other than those designated as Epson Approved Products by Seiko Epson
Corporation.

EPSON@® jsaregistered trademark, and EPSON EXCEED YOUR VISION or EXCEED YOUR VISION is a trademark
of Seiko Epson Corporation.

PRINT Image Matching " and the PRINT Image Matching logo are trademarks of Seiko Epson Corporation.
Copyright © 2001 Seiko Epson Corporation. All rights reserved.

SDXC Logo is a trademark of SD-3C, LLC.

Memory Stick Duo, Memory Stick PRO Duo, Memory Stick PRO-HG Duo, Memory Stick Micro, and MagicGate
Memory Stick Duo are trademarks of Sony Corporation.

Intel® is a registered trademark of Intel Corporation.

PowerPC® is a registered trademark of International Business Machines Corporation.
Epson Scan software is based in part on the work of the Independent JPEG Group.
libtiff

Copyright © 1988-1997 Sam Leffler
Copyright © 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is
hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in
all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics
may not be used in any advertising or publicity relating to the software without the specific, prior written
permission of Sam Leffler and Silicon Graphics.
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THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS,
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA ORPROFITS, WHETHER ORNOT ADVISED

OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN
CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Microsoft®, Windows®, and Windows Vista® are registered trademarks of Microsoft Corporation.
Apple®, Macintosh®, Mac OS®, and OS X® are registered trademarks of Apple Inc.

ABBYY® and ABBYY FineReader® names and logos are registered trademarks of ABBYY Software House.

Adobe, Adobe Reader, Acrobat, and Photoshop are trademarks of Adobe systems Incorporated, which may be
registered in certain jurisdictions.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their
respective owners. Epson disclaims any and all rights in those marks.

© 2012 Seiko Epson Corporation. All rights reserved.
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Introduction

Where to Find Information

The latest version of the following manuals are available on the Epson support website.
http://www.epson.eu/Support (Europe)
http://support.epson.net/ (outside Europe)
(1 Start Here (paper):
Provides you with information on setting up the product and installing the software.
4 Basic Guide (paper):
Provides you with basic information when you are using the product without a computer.
[d User’s Guide (PDF):
Provides you with detailed operating, safety, and troubleshooting instructions. See this guide when using this
product with a computer, or when using advanced features such as 2 sided copying.
To view the PDF manual, you need Adobe Acrobat Reader 5.0 or later, or Adobe Reader.
d Network Guide (HTML):
Provides network administrators with information on both the printer driver and network settings.

(4 Help (on the product display):

Provides basic operating and troubleshooting instructions on the product’s LCD screen. Select the Help menu on
the control panel.

Caution, Important and Note

Caution, Important and Note in this manual are indicated as below and have the following meaning.

must be followed carefully to avoid bodily injury.

Important
must be observed to avoid damage to your equipment.

Note
contain useful tips and restrictions on product operation.
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Operating System Versions

In this manual, the following abbreviations are used.

d  Windows 7 refers to Windows 7 Home Basic, Windows 7 Home Premium, Windows 7 Professional, and
Windows 7 Ultimate.

1  Windows Vistarefers to Windows Vista Home Basic Edition, Windows Vista Home Premium Edition, Windows
Vista Business Edition, Windows Vista Enterprise Edition, and Windows Vista Ultimate Edition.

d Windows XP refers to Windows XP Home Edition, Windows XP Professional x64 Edition, and Windows XP
Professional.

[ Mac OS X refers to Mac OS X 10.5.x, 10.6.x, 10.7.x.

Using Epson Connect Service

Using Epson Connect and other companies’ services, you can easily print directly from your smartphone, tablet PC or
laptop, anytime and practically anywhere even across the globe! For more information about printing and other
services, visit the following URL;

https://www.epsonconnect.com/ (Epson Connect portal site)

http://www.epsonconnect.eu/ (Europe only)

You can view the Epson Connect guide by double-clicking the E shortcut icon on the desktop.
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Safety Instructions

Read and follow these instructions to ensure safe use of this product. Make sure you keep this guide for future
reference. Also, be sure to follow all warnings and instructions marked on the product.

4 Useonly the power cord supplied with the product and do not use the cord with any other equipment. Use of other
cords with this product or the use of the supplied power cord with other equipment may result in fire or electric
shock.

[ Be sure your AC power cord meets the relevant local safety standard.

[d Never disassemble, modify, or attempt to repair the power cord, plug, printer unit, scanner unit, or options by
yourself, except as specifically explained in the product’s guides.

[d  Unplug the product and refer servicing to qualified service personnel under the following conditions: The power
cord or plug is damaged; liquid has entered the product; the product has been dropped or the casing damaged; the
product does not operate normally or exhibits a distinct change in performance. Do not adjust controls that are
not covered by the operating instructions.

[ Place the product near a wall outlet where the plug can be easily unplugged.

[ Do not place or store the product outdoors, near excessive dirt or dust, water, heat sources, or in locations subject
to shocks, vibrations, high temperature or humidity.

[ Take care not to spill liquid on the product and not to handle the product with wet hands.

4 Keep this product at least 22 cm away from cardiac pacemakers. Radio waves from this product may adversely
affect the operation of cardiac pacemakers.

(4 Ifthe LCD screen is damaged, contact your dealer. If the liquid crystal solution gets on your hands, wash them
thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them immediately with
water. If discomfort or vision problems remain after a thorough flushing, see a doctor immediately.

d  Avoid using a telephone during an electrical storm. There may be a remote risk of electric shock from lightning
(for fax capable models).

[d Do not use a telephone to report a gas leak in the vicinity of the leak (for fax capable models).

Note:

The following provides safety instructions for ink cartridges.
™ “Replacing Ink Cartridges” on page 110

Product Advisories and Warnings

Read and follow these instructions to avoid damaging the product or your property. Make sure you keep this guide for
future reference.

10
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Setting up/using the product

Do not block or cover the vents and openings in the product.

Use only the type of power source indicated on the product’s label.

Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch on and off.

Avoid electrical outlets controlled by wall switches or automatic timers.

I T N S

Keep the entire computer system away from potential sources of electromagnetic interference, such as
loudspeakers or the base units of cordless telephones.

(4 The power-supply cords should be placed to avoid abrasions, cuts, fraying, crimping, and kinking. Do not place
objects on top of the power-supply cords and do not allow the power-supply cords to be stepped on or run over. Be
particularly careful to keep all the power-supply cords straight at the ends and the points where they enter and
leave the transformer.

d  Ifyou use an extension cord with the product, make sure that the total ampere rating of the devices plugged into
the extension cord does not exceed the cord’s ampere rating. Also, make sure that the total ampere rating of all
devices plugged into the wall outlet does not exceed the wall outlet’s ampere rating.

4 Ifyou plan to use the product in Germany, the building installation must be protected by a 10 or 16 amp circuit
breaker to provide adequate short-circuit protection and over-current protection for the product.

(d  When connecting the product to a computer or other device with a cable, ensure the correct orientation of the
connectors. Each connector has only one correct orientation. Inserting a connector in the wrong orientation may
damage both devices connected by the cable.

4 Place the product on a flat, stable surface that extends beyond the base of the product in all directions. If you place
the product by the wall, leave more than 10 cm between the back of the product and the wall. The product will not
operate properly if it is tilted at an angle.

4 Place the product with its right side at least 10 cm away from the wall or any other objects (for fax capable models).

[ When storing or transporting the product, avoid tilting it, placing it vertically, or turning it upside down;
otherwise ink may leak.

4 Allow spaces behind the product for the cables, and space above the product so that you can fully raise the
document cover.

U

Leave enough space in front of the product for the paper to be fully ejected.

U

Avoid places subject to rapid changes in temperature and humidity. Also, keep the product away from direct
sunlight, strong light, or heat sources.

Do not insert objects through the slots in the product.
Do not put your hand inside the product or touch the ink cartridges during printing.

Do not touch the white flat cable inside the product.

U o0 o0 U

Do not use aerosol products that contain flammable gases inside or around the product. Doing so may cause
fire.

11
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d Do not move the print head by hand; otherwise, you may damage the product.

Q  Always turn the product off using the O button. Do not unplug the product or turn off the power at the outlet until
the LCD screen has turned off completely.

[ Before transporting the product, make sure that the print head is in the home (far right) position and the ink
cartridges are in place.

[d  Be careful not to trap your fingers when closing the scanner unit.

[d Ifyou are not going to use the product for a long period, be sure to unplug the power cord from the electrical
outlet.

[ Do not press too hard on the scanner glass when placing the originals.

(4 During the life of your product it may be necessary to replace the waste ink pad when it has become full. Whether
and how often this is required will vary according to the number of pages you print, the type of material that you
print and the number of cleaning cycles that the product performs. Epson Status Monitor, your LCD, or lights on
the control panel will advise you when this part needs replacing. The need for replacement of the pad does not
mean that your product has ceased to operate in accordance with its specifications. The replacement of this part is
aroutine product servicing activity within the product’s specification and is not a problem which requires repair.
The Epson warranty does not therefore cover the cost of this replacement. If your product needs the pad replacing
this can be performed for you by any authorised Epson service provider. It is not a user-serviceable part.

Using the product with a wireless connection

[d Do not use this product inside medical facilities or near medical equipment. Radio waves from this product may
adversely affect the operation of electrical medical equipment.

[ Do notuse this product near automatically controlled devices such as automatic doors or fire alarms. Radio waves
from this product may adversely affect these devices, and could lead to accidents due to malfunction.

Using memory cards

[d Do not remove a memory card or turn off the product while the memory card light is flashing.

(4 The methods for using memory cards vary according to card type. Be sure to refer to the documentation packaged
with your memory card for details.

4 Use only memory cards compatible with the product.
= “Memory card” on page 169

Using the touch panel

[ The LCD screen may contain a few small bright or dark spots, and because of its features it may have an uneven
brightness. These are normal and do not indicate that it is damaged in any way.

[ Only use a dry, soft cloth to clean the touch panel and touchpad. Do not use liquid or chemical cleansers.

[ Theexterior cover of the touch panel and touchpad could break if it receives a heavy impact. Contact your dealer if
the panel surface chips or cracks, and do not touch or attempt to remove the broken pieces.

12
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[ Press the touch panel and touchpad gently with your finger. Do not press force or operate with your nails.
4 Do not operate by a sharp edge thing such as a ball point pen, sharp pencil, stylus pen and so on.

[ Condensation inside the panel due to abrupt changes in temperature or humidity may cause performance to
deteriorate.

Handling ink cartridges

= “Replacing Ink Cartridges” on page 110

Restrictions on Copying

Observe the following restrictions in order to ensure the responsible and legal use of the product.

Copying of the following items is prohibited by law:

4 Bankbills, coins, government-issued marketable securities, government bond securities, and municipal securities
4 Unused postage stamps, pre-stamped postcards, and other official postal items bearing valid postage

1 Government-issued revenue stamps, and securities issued according to legal procedure

Exercise caution when copying the following items:

4 Private marketable securities (stock certificates, negotiable notes, checks, etc.), monthly passes, concession
tickets, etc.

4 Passports, driver’s licenses, warrants of fitness, road passes, food stamps, tickets, etc.

Note:
Copying these items may also be prohibited by law.

Responsible use of copyrighted materials:
[ Products can be misused by improperly copying copyrighted materials. Unless acting on the advice of a

knowledgeable attorney, be responsible and respectful by obtaining the permission of the copyright holder before
copying published material.

Protecting Your Personal Information

This product allows you to store names and telephone numbers in its memory even when the power is turned off.
Use the following menu to erase the memory if you give the product to someone else or dispose of it.

¥ Setup > Restore Default Settings > All Settings

13
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Available features for your product

Check what is available for your product.

XP-750 XP-850
Print v 4
Copy v v
Scan v v
Fax - 4
ADF - v
Ethernet v v
Wi-Fi v v

Product Parts

Note:
The illustrations in this manual are from a similar product model. Although they may differ from your actual product, the
method of operation is the same.

a. Automatic Document Feeder (ADF)*

b. Edge guide*

[ ADF input tray (place your originals here to be copied)*
d. ADF output tray extension (slide out the extension when using the ADF)*
e. ADF output tray (your originals are ejected here as they are copied)*

14
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f. ADF cover*

g. CD/DVD tray

* The availability of this part varies by product.

e
a. Document cover
b. Cassette 1 (upper cassette)*!
c Cassette 2 (lower cassette)*!
d. Front cover*!
e. Control panel*?

*1 See the following illustration for details.

*2 The control panel raises automatically when printing starts. Lower it manually if necessary.

e

a. Output tray*
b. Cassette 1

c. Cassette 2
d. Front cover
e. Edge guides

* The output tray slides out automatically when printing starts. Close it manually if necessary.

15
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a. Rear paper feed slot

b. Paper support

a. Document mat
b. Scanner glass
C. Memory card light
d. Memory card slots
e. External interface USB port
a
a. Scanner unit

16
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b. Print head / Ink cartridge holder

DO

a. ACinlet
b. Rear cover
C. LAN port

d. LINE port*

e. EXT. port*

f. USB port

* The availability of this part varies by product.

Guide to the Control Panel

Note:
A Control panel design varies depending on location.

[ Although the control panel design and what displayed on the LCD screen such as menu names and option names may
differ from your actual product, the method of operation is the same.

a b C d
| |

B 4

D
e | ¢
e f g

Button and LCD
Buttons Function
a d) Turns the product on or off.

17
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Buttons

Function

b ®

Displays the Home menu.

LCD screen displays menus.

If your product has a touch panel, you can scroll the screen by swiping the LCD screen.
Swipe the center of LCD screen quickly.

Try swiping a bit harder if the touch panel is slow to respond.

Scrolls the screen.

Press to display the CD/DVD label menu.
The product prepares CD/DVD label printing.

Cancels/returns to the previous menu.

Starts copying/printing/scanning/faxing.

About Auto Selection Mode

Auto Selection Mode displays menus according to your actions.

Note:

1 When you insert a memory card, open the document cover, or load a document in the ADF, the LCD screen may not
display the desired menu. In this case, press {i to display the Home menu.

A To disable this function, turn off each item in the Auto Selection Mode menu. Setup > Guide Functions > Auto
Selection Mode.

Lights

Lights

Function

b

On when the product is on.

Flashes when the product is receiving data, printing/copying/scanning/faxing, replacing an ink cartridge,
charging ink, or cleaning the print head.

Flashes slowly when the product is in sleep mode.
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Lights Function
— Stays on while the printer is connected to a network. Flashes while network settings are being adjusted
@ (green: Wi-Fi/orange: Ethernet). This light turns off in sleep mode.
Note:

See the Help on the control panel for more information on the icons displayed on the LCD screen.
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Paper and Media Handling

Introduction to Using, Loading, and Storing Media

You can achieve good results with most types of plain paper. However, coated papers provide superior prints because
they absorb less ink.

Epson provides special papers that are formulated for the ink used in Epson ink jet products, and recommends these
papers to ensure high-quality results.

When loading special paper distributed by Epson, read the instruction sheets packed with the paper first and keep the
following points in mind.

Note:

A Load the paper into the paper cassette printable side down. The printable side is usually whiter or glossier. See the
instruction sheets packed with the paper for more information. Some types of paper have cut corners to help identify the
correct loading direction.

[ Ifthe paper is curled, flatten it or curl it slightly in the opposite direction before loading. Printing on curled paper may
cause ink to smear on your prints.

Storing paper

Return unused paper to the original package as soon as you finish printing. When handling special media, Epson
recommends storing your prints in a resealable plastic bag. Keep unused paper and prints away from high
temperature, humidity, and direct sunlight.

Selecting Paper

The table below lists supported papers. Loading capacity and borderless print availability varies by paper as shown.
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Media Type Size Loading capacity (sheets) Borderless
printing*’
cassette 2 cassette 1 rear paper
(lower (upper feed
cassette) cassette) slot*3%6
Plain paper*! Letter*2 upto1Tmm | - 1 -
A4*2 upto 11 mm - 1 -
B5*2 upto 11 mm - 1 -
A5*2 upto 11 mm - 1 -
A6*3 up to 2 mm up to 2 mm 1 -
Legal** 1 - 1 -
User defined size 1 - 1 -
Envelope #10 10 - 1 -
DL 10 - 1 -
cé6 10 - 1 -
Epson Bright White Ink Jet A4*3 80 - 1 -
Paper
Epson Photo Quality Ink Jet A4 80 - 1 -
Paper
Epson Matte A4 20 - 1 v
Paper-Heavyweight
Epson Double-Sided Matte A4*4 1 - 1 v
Paper
Epson Photo Paper A4 20 - 1 v
10x15cm (4 x6in.) 20 20 1 v
13%x18cm (5% 7in.) 20 20 1 v
Epson Premium Glossy Photo A4 20 - 1 v
Paper
10x15cm (4 X 6in.) 20 20 1 v
13x18cm (5% 7in.) 20 20 1 v
16:9 wide size 20 20 1 v
(102 x 181Tmm)
Epson Premium Semigloss A4 20 - 1 v
Photo Paper
10x15cm (4%x6in.) 20 20 1 v
Epson Ultra Glossy Photo A4 20 - 1 v
Paper
10x15cm (4x6in.) 20 20 1 v
13x18cm (5% 7in.) 20 20 1 v
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Media Type Size Loading capacity (sheets) Borderless
printing*’
cassette 2 cassette 1 rear paper
(lower (upper feed
cassette) cassette) slot*3%6
Epson Glossy Photo Paper A4 20 - 1 v
10x15cm (4% 6in.) 20 20 1 v
13x18cm(5x7in.) 20 20 1 v
Epson Iron-On Cool Peel A4 1 - 1 -
Transfer Paper
Epson Photo Stickers A6 1 1 1 -

*1 Paper with a weight of 64 g/m? (17 Ib) to 90 g/m? (24 Ib).

*2 The loading capacity for manual 2-sided printing is 30 sheets.

*3 The loading capacity for manual 2-sided printing is 20 sheets.

*4 The loading capacity for manual 2-sided printing is 1 sheet.

*5 Rear paper feed slot may not be available for some models.

*6 Even though you can print on paper with a thickness of 0.05 to 0.6 mm, some hard paper may not be fed correctly even if the

thickness is within this range.

*7 Borderless printing is not available for 2-sided printing.

Note:
The availability of paper varies by location.

Paper type settings on the LCD screen

The product automatically adjusts itself for the type of paper you select in your print settings. That is why the paper
type setting is so important. It tells your product what kind of paper you are using and adjusts the ink coverage
accordingly. The table below lists the settings you should choose for your paper.

For this paper LCD paper type
Plain paper* Plain Paper
Epson Bright White Ink Jet Paper* Plain Paper
Epson Ultra Glossy Photo Paper Ultra Glossy
Epson Premium Glossy Photo Paper Prem. Glossy
Epson Premium Semigloss Photo Paper Prem. Glossy
Epson Glossy Photo Paper Glossy
Epson Photo Paper Photo Paper
Epson Photo Quality Ink Jet Paper Matte

Epson Matte Paper-Heavyweight Matte

Epson Double-Sided Matte Paper Matte
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Epson Photo Stickers

Photo Sticker

* You can perform 2-sided printing with this paper.

Paper type settings from the printer driver

The product automatically adjusts itself for the type of paper you select in your print settings. That is why the paper
type setting is so important. It tells your product what kind of paper you are using and adjusts the ink coverage
accordingly. The table below lists the settings you should choose for your paper.

For this paper

Printer driver paper type

Plain paper* plain papers
Epson Bright White Ink Jet Paper* plain papers
Epson Iron-On Cool Peel Transfer Paper plain papers

Epson Ultra Glossy Photo Paper*

Epson Ultra Glossy

Epson Premium Glossy Photo Paper*

Epson Premium Glossy

Epson Premium Semigloss Photo Paper*

Epson Premium Semigloss

Epson Glossy Photo Paper*

Epson Glossy

Epson Photo Paper*

Epson Photo

Epson Photo Quality Ink Jet Paper*

Epson Photo Quality Ink Jet

Epson Matte Paper - Heavyweight*

Epson Matte

Epson Double-Sided Matte Paper*

Epson Matte

Epson Photo Stickers*

Epson Photo Stickers

Envelopes

Envelope

* These paper types are compatible with Exif Print and PRINT Image Matching. For more information, refer to the documentation
that came with the Exif Print or PRINT Image Matching compatible digital camera.

Note:

Epson support.
= “Technical Support Web Site” on page 175

The availability of special media varies by location. For the latest information on media available in your area, contact
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Loading Paper

Into the paper cassette

Note:
A Although the instructions in this section are based on cassette 2, the method of operation is the same for cassette 1.

A The available paper type, size and loading capacity differs between cassette 1 and 2. See the following section for more
information on paper availability.
= “Selecting Paper” on page 20

Open the front cover.

Note:
If the output tray has been ejected, close it before pulling out the paper cassette.

Pull out the paper cassette.
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Slide the edge guides to the sides of the paper cassette.

Note:
When using Legal-size paper, remove the CD/DVD tray, and then extend cassette 2 as shown in the illustration.

Note:
If you are loading envelopes, skip this step.

Load paper toward the edge guide with printable side face-down, and check that the paper is not sticking out
from the end of the cassette.
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Note:

A Fan and align the edges of the paper before loading.

0 For plain paper, do not load paper above the line just under the s=== arrow mark inside the edge guide. For
Epson special media, make sure the number of sheets is less than the limit specified for the media.
® “Selecting Paper” on page 20

[ When you select Cassette 1>Cassette 2 as the Paper Source, load the same size and type of paper in both
cassettes.

0

When loading a Photo Stickers sheet, place it face down. Do not use the loading support sheet that came with the
Photo Stickers.

Use cassette 2 when loading envelopes. Load envelopes short edge first with the flap facing up and to the left.
Next, check that the envelopes are not sticking out from the end of the cassette.

SIS
N
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Note:

0 The thickness of envelopes and their ability to fold vary widely. If the total thickness of the stack of envelopes
exceeds 11 mm, press down on the envelopes to flatten them before loading. If print quality declines when a stack
of envelopes is loaded, load one envelope at a time.

® “Selecting Paper” on page 20
A Do not use envelopes that are curled or folded.

A Flatten the envelope and the flaps before loading.

&) 2

A Flatten the leading edge of the envelope before loading.

U

Avoid using envelopes that are too thin, as they may curl during printing.

[ Align the edges of the envelopes before loading.

E Slide the edge guides to the edges of the paper.

0@@

Slide the edge guides to the edges of the envelopes.
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Note:
0 Leave enough space in front of the product for the paper to be fully ejected.

0 Do not remove or insert the paper cassette while the product is operating.

Into the rear paper feed slot

Note:
Even though you can print on paper with a thickness of 0.05 to 0.6 mm, some hard paper may not be fed correctly even if the

thickness is within this range.

Send your print job to the product (from your computer, or by using the control panel).

Note:
Before sending your print job, you cannot load paper into the rear paper feed slot.

Open the rear paper feed slot cover and then pull out the paper support.

Slide the edge guide.
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n Load a single sheet of paper with the printable side face-up at the center of the rear paper feed slot, and then set
the edge guide. The printable side is often whiter or brighter than the other side.

|||||
[T

Note:
Insert the paper so that the leading edge is approximately 5 cm from the groove in the edge guides.

o ST
2 Jadh -

Load the envelope short edge first with the flap facing down and at the center of the rear paper feed slot, and then
set the edge guide.
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Note:
A Do not use an envelope that is curled or folded.

1 Flatten the envelope and the flaps before loading.

) 2

[  Flatten the leading edge of the envelope before loading.

1 Avoid using an envelope that is too thin, as it may curl during printing.

Press <.

Note:
The paper or envelope ejects automatically after a certain period of time.

Loading a CD/DVD

n Important:

4 Do not insert the CD/DVD tray while the product is operating. Otherwise, your product may be damaged or the
surface of the CD/DVD may become dirty or scratched.

[ When ejecting/inserting the CD/DVD tray, make sure nothing is placed on the output tray.

Note: .
You can also print on a Blu-ray Disc .

Press @ on the control panel, and then select Load CD/DVD.

Raise the panel as far as it will go.

=
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Note:
If the output tray has been ejected, close the tray and the front cover.

n Placea CD/DVD on the CD/DVD tray with the printable side face-up, and then insert the tray into the product.
Make sure that the A marks on the tray and the ¥ marks on the product match, so that the line on the tray aligns
with the product.

Press Done on the LCD screen.

Note:
The CD/DVD tray ejects automatically after a certain period of time.
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Removing a CD/DVD

Remove the CD/DVD tray from the product, and then remove your CD/DVD from the tray.

Be careful not to scratch the surface of the CD/DVD when removing it.

Lower the control panel.

Insert the CD/DVD tray back into the slot on the bottom of the product.

Inserting a Memory Card

You can print photos in a memory card or save a scanned data in a memory card. The following memory cards are
supported.

SD, miniSD, microSD, SDHC, miniSDHC, microSDHC, SDXC, microSDXC, MultiMediaCard, MMCplus,

MMCmobile, MM Cmicro, Memory Stick Duo, Memory Stick PRO Duo, Memory Stick PRO-HG Duo, Memory Stick
Micro, MagicGate Memory Stick Duo, CompactFlash, Microdrive
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Important

The following memory cards require an adapter. Attach it before inserting the card into the slot, otherwise the card
may get stuck.

A miniSD, microSD, miniSDHC, microSDHC, microSDXC, MMCmicro

—

d  MMCmobile

4 Memory Stick Micro

()

&
Check the light stays on.

[] =on, [[] = flashing
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n Important

[ Do not try to force the card all the way into the slot. It should not be fully inserted.

[ Do not remove the memory card while the light is flashing. The data in the memory card may be lost.

Note:

A Ifyou have more than 999 images on your memory card, images are automatically divided into groups and the group
selection screen is displayed. Select the group that contains the image you want to print. Images are sorted by the date
they were taken.

A Toselect another group, select Print Photos on the Home menu. Next, select Options, Select Location, and then Select
Folder or Select Group.

Placing Originals

Automatic Document Feeder (ADF)

Note:
The Automatic Document Feeder is only available for XP-850.

You canload your original documents in the Automatic Document Feeder (ADF) to copy, scan, or fax multiple pages
quickly. The ADF can scan both sides of your documents. To do so, select the option in the copy setting menu.

You can use the following originals in the ADF.

Size A4/Letter/Legal

Type Plain paper

Weight 64 g/m? to 95 g/m?

Capacity 30 sheets or 3 mm or less (A4, Letter)/10 sheets (Legal)

When you scan a 2-sided document using the ADF, legal size paper is not available.

n Important:

To prevent paper jams, avoid the following documents. For these types, use the scanner glass.

1 Documents held together with paper clips, staples, etc.
1 Documents that have tape or paper stuck to them.

1 Photos, OHPs, or thermal transfer paper.
l:l

Paper that is torn, wrinkled, or has holes.
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Tap the originals on a flat surface to even the edges.

n Insert the originals face-up and short edge first into the Automatic Document Feeder, and then slide the edge
guide until it is flush with the originals.

Note:
The ADF icon is displayed when originals are placed in the automatic document feeder.
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Note:
A For A4, 2-up Copy layout, place the original as shown. Make sure the orientation of the original matches the Document
Orientation settings.

=X
=®

d  When you use the copy function with the Automatic Document Feeder (ADF), the print settings are fixed at Reduce/
Enlarge - Actual Size, Paper Type - Plain Paper, and Paper Size - A4. The print is cropped if you copy an original larger
than A4.

Scanner glass

Open the document cover.
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Note:

See the following sections if any problems occur with the scanning area or the scanning direction when using EPSON
Scan.

™ “The edges of your original are not scanned” on page 159

> “Multiple documents are scanned into a single file” on page 159

Close the cover gently.

Note:
When there is a document in the Automatic Document Feeder (ADF) and on the scanner glass, priority is given to the
document in the Automatic Document Feeder (ADF).

Placinga CD

Place the CD face-down in the center.

-
ot Torm Tos

Placing photos

Place photos 5 mm apart.

&

T
Tas IR les

2
?

Note:
You can copy one photo or multiple photos of different sizes at the same time, as long as they are larger than 30 x 40 mm.
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Placing a book

Place the first page, and then place the second page.

You can print two pages of a book on a single side of one sheet of paper. Select A4, Book/2-up or Book/2-Sided as the
layout and place the book.

Note:
Close the document cover to avoid direct light, such as fluorescent lights, when scanning. Otherwise, the light may affect the
scanning result.
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Copying

Copying Documents

Basic copying
Follow the steps below to copy documents.

Load paper in the cassette 2.
= “Into the paper cassette” on page 24

Place original.

= “Placing Originals” on page 34

Enter Copy mode from the Home menu.
Press + or - to set the number of copies.
Set the color.

Press ¥ to make the copy settings.

Select the appropriate copy settings such as paper size, paper type, and paper quality.

MBS AENE

Note:
0 You can preview the copy results before you start copying.

0 You can make various layout copies such as 2-sided copy, 2-up copy, and so on. Change the 2-sided or layout
settings as necessary.

E Press < to start copying.

2-Sided copying

With duplex copying, you can create double-sided or single-sided copies from double-sided or single-sided originals.
Follow the instructions below to perform duplex copying.

Load paper in the cassette 2.
= “Into the paper cassette” on page 24

Place original.
= “Placing Originals” on page 34
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Set the color.

ol goRo NS N

Select 2-Sided Copying.

Copying

Enter Copy mode from the Home menu.

Press + or - to set the number of copies.

Press ¥ to make the copy settings.

Select the type of 2-sided copying.

Setting Description

1>1-Sided Normal copying.

1>2-Sided Two single-sided originals are printed onto each side of a single sheet of paper.
2>1-Sided* Each side of a double-sided original is printed onto one side of a single sheet of paper.
2>2-Sided* Each side of a double-sided original is printed onto each side of a single sheet of paper.

* Depending on the model, this function may not be available.

E Make the appropriate settings for Document Orientation, Binding Direction, or Binding Margin.

Setting

Description

Document Orientation

Specifies the orientation of your originals.

Binding Direction*

Specifies the binding direction of your originals.

Binding Margin

Specifies the binding direction of your prints.

* Depending on the model, this function may not be available.

Note:

Depending on the settings for 2-Sided Copying and Layout, these menus may not be available.

Press < to start copying.

Layout copying

With the layout function, you can copy two single-sided originals onto a single page.

1 Load paper in the cassette 2.

= “Into the paper cassette” on page 24
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Place original.

= “Placing Originals” on page 34

Enter Copy mode from the Home menu.
Press ¥ to make the copy settings.

Select Layout.

Select A4, 2-up Copy.

Press & to start copying.

~Sgool~ RN

Copy Mode Menu List

Refer to the section below for the Copy mode menu list.
= “Copy Mode” on page 100
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Printing

Basic Operation from the Control Panel

Printing photos from a memory card

Load photo paper in the paper cassette.
= “Into the paper cassette” on page 24

Insert a memory card.

= “Inserting a Memory Card” on page 32

Note:
You can also print photos from an external USB device.

>l

Enter Print Photos mode from the Home menu.

Select a photo and press + or - to set the number of copies.

gOtei’ou can crop and enlarge your photo. Press Edit and Crop/Zoom, and then make the settings.

0 To select more photos, press 5 and repeat step 4.

A Ifyouwant to correct your images, press Edit and Photo Adjustments, and then make the settings. Scroll down
if necessary.

A Ifthe screen display (for example, "-","+", or menus) disappears, touch the LCD screen.

Press Settings, and then make the print settings. Scroll down if necessary.

E Press < to start printing.

Note

See the following sections for more information on other printing functions available from the control panel.
= “Print Photos Mode” on page 100
= “More Functions” on page 98

Printing photos from a digital camera

1 Load photo paper in the paper cassette.
= “Into the paper cassette” on page 24
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Remove a memory card.

Enter Setup mode from the Home menu.

n Enter External Device Setup. Scroll down if necessary.

Select Print Settings.

E Make the appropriate print settings. Scroll down if necessary.

Connect the camera to the product with a USB cable, and then turn on the camera.

E See your camera’s guide to print.

Compatibility PictBridge
File Format JPEG
Image Size 80 x 80 pixels to 9200 x 9200 pixels
Note:
A Depending on the settings on this printer and the digital camera, some combinations of paper type, size, and layout may
not be supported.
A Some of the settings on your digital camera may not be reflected in the output.

Print photos mode menu list

Refer to the section below for the Print Photos mode menu list.
= “Print Photos Mode” on page 100
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Basic Operation from Your Computer

Printer driver and status monitor

The printer driver lets you choose from a wide variety of settings to get the best printing results. The status monitor and
the printer utilities help you check the product and keep it in top operating condition.

Note for Windows users:

A Your printer driver automatically finds and installs the latest version of the printer driver from Epson’s Web site. Click
the Software Update button in your printer driver’s Maintenance window, and then follow the on-screen instructions.
If the button does not appear in the Maintenance window, point at All Programs or Programs in the Windows Start
menu, and check in the EPSON folder.

O Ifyou want to change the language of the driver, select the language you want to use from the Language setting in your
printer driver’s Maintenance window. Depending on the location, this function may not be available.

Accessing the printer driver for Windows

You can access the printer driver from most Windows applications, the Windows Start menu, or the taskbar.
To make settings that apply only to the application you are using, access the printer driver from that application.

To make settings that apply to all of your Windows applications, access the printer driver from the Start menu or the
taskbar.

Refer to the following sections to access the printer driver.

Note:
Screen shots of the printer driver windows in this User’s Guide are from Windows 7.

From Windows applications
Click Print or Print Setup on the File menu.

In the window that appears, click Printer, Setup, Options, Preferences, or Properties. (Depending on your
application, you may need to click one or a combination of these buttons.)

From the Start menu

d Windows 7:
Click the start button, select Devices and Printers. Then right-click the product and select Printing
preferences.

1 Windows Vista:
Click the start button, select Control Panel, and then select Printer from the Hardware and Sound category.
Then select the product and then click Select printing preferences.

(d Windows XP:

Click Start, Control Panel, (Printers and Other Hardware,) then Printers and Faxes. Select the product, then
click Printing Preferences on the File menu.
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From the shortcut icon on the taskbar

Right-click the product icon on the taskbar, then select Printer Settings.

To add a shortcuticon to the Windows taskbar, first access the printer driver from the Start menu as described above.
Next, click the Maintenance tab, the Extended Settings button, and then the Monitoring Preferences button. In the
Monitoring Preferences window, select the Shortcut Icon check box.

Getting information through online help

In the printer driver window, try one of the following procedures.

d  Right-click the item, then click Help.

[  Click the ﬂ button at the top right of the window, then click the item (for Windows XP only).

Accessing the printer driver for Mac OS X

The table below describes how to access the printer driver dialog.

Dialog Box How to Access It
Page Setup Click Page Setup on the File menu of your application.

Note:

Depending on your application, the Page Setup menu may not appear in the File menu.
Print Click Print on the File menu of your application.

Epson Printer Utility 4

For Mac OS X 10.7, click System Preferences on the Apple menu and then click Print & Scan.
Select your product from the Printers list box, click Options & Supplies, Utility, and then click
Open Printer Utility.

ForMacOS X 10.6, click System Preferences onthe Apple menuandthen click Print & Fax. Select
your product from the Printers list box, click Options & Supplies, Utility, and then click Open
Printer Utility.

ForMacOS X 10.5, click System Preferences on the Apple menu and then click Print & Fax. Select
your product from the Printers list box, click Open Print Queue and then click Utility button.

Getting information through online help

Click the ?_’, Help button in the Print dialog box.

Basic Printing

Note:

[ The screen shots in this section may vary depending on the model.

[ Before you print, load paper properly.
= “Loading Paper” on page 24

[ Refer to the section below for the printable area.
™ “Printable area” on page 166

[ After completing the settings, print one test copy and examine the results before printing an entire job.
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Basic product settings for Windows

Open the file you want to print.

2

o S o

Access the printer settings.
= “Accessing the printer driver for Windows” on page 44

=) Printing Preferences [==3s]
' Shodeu ]E‘Hﬂ“"[ & Advanced | [ Page Layout | +* Maintenance|
Qualty Option
[ — - a |
— =t
S B -
) Draft @ Text ) Text B Image () Photo () Best Photo
Paper Options 2-cidad printing
O A
Source  Autn Cassette Selection - o o'::”
Type plan papers - Pn-n Options -
Size  Letter 8 1f2x 1lin - [ |Fix Red-Eye
@) Borders Borderless | Reverse Order
| Pring Preview
Ink Levels Orientation
l @ Portrait
() Landscape
[ How to Buy l
[#] shaw this sereen first
s ()
[ ok || conead || Hew |

Click the Main tab.

Select the appropriate Source setting.
= “Selecting Paper” on page 20

Select the appropriate Type setting.
= “Paper type settings from the printer driver” on page 23

Note:
Print quality is automatically adjusted for the selected paper type setting.

Select Borderless if you want to print borderless photos.
= “Selecting Paper” on page 20

Ifyouwantto control theamount of the image that extends beyond the edges of the paper, click the Page Layout
tab, select Auto Expand as the Enlargement Method, and then adjust the Expansion slider.

Select the appropriate Size setting. You can also define a custom paper size. For details, see the online help.
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E Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

Note:
Select Landscape when printing on envelopes.

E Click OK to close the printer settings window.

Note:
To make changes to advanced settings, refer to the relevant section.

Print your file.

Basic product settings for Mac OS X

Note:
Screen shots of the printer driver windows in this section are from Mac OS X 10.7.

Open the file you want to print.

Access the Print dialog box.
= “Accessing the printer driver for Mac OS X” on page 45

Printer: | EPSON XXX

ar |<p.

Presets: | Default Settings

Copies: |1 |

Pages: (=) All
(_JFrem: |1 to: |1

(_Selected Page in Sidahar

Paper Size: | A4 + | §.27 by 11.69 inches

Orientation: I!;_I |T'a--'|

| Preview |

EI Auto Rotate

| | Scale: 90 %
\EJ Scale to Fit: ‘c:u Print Entire Image
[ | Fill Entire Paper

Copies per page: | 1 sl

(Cancel | [
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Note:

If the simplified status monitor is displayed, click the Show Details button (for Mac OS X 10.7) or the ¥ button (for
Mac OS X 10.6 or 10.5) to extend this dialog box.

Select the product you are using as the Printer setting.

Note:

Depending on your application, you may not be able to select some of the items in this dialog box. If so, click Page
Setup on the File menu of your application, and then make suitable settings.

Select the appropriate Paper Size setting.

Note:

Select XXX (Borderless) as the Paper Size if you want to print borderless photos
= “Selecting Paper” on page 20

Select the appropriate Orientation setting.

Note:

Select landscape orientation when printing envelopes.

E Select Print Settings from the pop-up menu.

Printer: | EPSON XX0(X

Presets: | Default Settings

Copies: D
Pages: @-AII

.k_, From: 1 to: |1

() Selected Page in Sidebar

Paper Size: | A4

Orientation: lﬁl IS

| SS—

——| Print Settings Bi

Paper Source: | Cassette 2

+ | 8.27 by 11.69 inches

Media Type: | plain papers
Print Quality: | Normal

|li||1l_|1h

Borderless

Expansion: | Max D

[ | Grayscale

| Mirror Image

| Cancel |§| Print |
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Select the appropriate Paper Source setting.

Select the appropriate Media Type setting.
= “Paper type settings from the printer driver” on page 23

Select the appropriate Expansion setting during borderless printing to control the amount of the image that
extends beyond the edges of the paper.

Click Print to start printing.

o ool

Canceling Printing

If you need to cancel printing, follow the instructions in the appropriate section below.

Using the control panel

Press @ to cancel a print job in progress.

For Windows

Note:
You cannot cancel a print job that has been completely sent to the product. In this case, cancel the print job by the product.

Using the progress meter

When you start printing, the progress meter appears on your computer screen.

Click the Cancel button to cancel printing.

LT EpSON 3000 =2 ISR
EP‘SON Doounent. pdf Page:31/37
)
Media Type : plan papers -
Paper Size 1 Letter 8 1/2x 11in
Print Queue | Cancel Buy Epson Ink

Using EPSON Status Monitor 3

Access the EPSON Status Monitor 3.
= “For Windows” on page 136

Click the Print Queue button. The Windows Spooler appears.

Right click on the job you want to cancel and then select Cancel.
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For Mac OS X

Follow the steps below to cancel a print job.

Click your product icon in the Dock.
In the Document Name list, select the document which is printing.

Click the Delete button to cancel the print job.

[ HaN= B EFSON X000

9]t 0 w m

Oelete Job Info - Paie Printer Supply Levels  Pricter Setup

Printing *Epson_FontCulde_EN.pdf™

. Copy 1 ol 1, Page 26 of 39, Sheet 26 of 39,

., . Y

[ Printing Tosan_foniCuste tN.pdl 12:33 Pl ]

Other Options

Printing photos the easy way

Epson Easy Photo Print lets you lay out and print digital images on various types of paper. The step-by-step
instructions in the window let you preview the printed images and get the effects you want without having to make any
difficult settings.

Using the Quick Print function, you can perform one-click printing with the settings you make.

Starting Epson Easy Photo Print

For Windows
(4 Double-click the Epson Easy Photo Print icon on the desktop.

50



User’s Guide

Printing

1 For Windows 7 and Vista:
Click the start button, point to All Programs, click Epson Software, and then click Easy Photo Print.
For Windows XP:
Click Start, point to All Programs, point to Epson Software, then click Easy Photo Print.

For Mac OS X

Double-click the Applications folder on your Mac OS X hard drive, then double-click in turn on the Epson Software
and Easy Photo Print folders and finally double-click the Easy Photo Print icon.

Printing on CD/DVD

Epson Print CD lets you create CD/DVD labels with text and images on your computer, then print the labels directly
onto 12-cm CDs and DVDs.

Note:

d  Before you print, load the CD/DVD properly.
® “Loading a CD/DVD” on page 30

d  Try to test print on a spare CD/DVD and check the printed surface after waiting for one full day, especially before
printing a large amount of CD/DVDs.

1 You can also print on CD/DVDs from the control panel.

= “More Functions” on page 98

Notice for CD/DVD printing

4

4

Print only on a circular CD/DVD.
See the documentation provided with your CD/DVD for more information on handling the CD/DVD.

Do not print on the CD/DVD before writing your data to it. If you do, fingerprints, dirt, or scratches on the surface
may cause errors while writing data.

Store the CD/DVD tray in the bottom slot of the product. A warped or damaged CD/DVD tray may stop the
product from operating normally.

If the tray is ejected or not fed correctly when you start a CD/DVD print job, make sure that you inserted the tray
properly.
= “Loading a CD/DVD” on page 30

Ifthe tray is ejected when you start a CD/DVD print job, the product is not ready. Wait until you see a message on
your computer screen asking you to insert the tray. Then reinsert the tray and press ©.

After you finish printing on a CD/DVD, remove the CD/DVD tray.
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4 Useonly CD/DVD labelled as suitable for printing, for example “Printable on the label surface” or “Printable with
ink jet printers”.

(d  Depending on the CD/DVD type, smearing may occur depending on the level of color saturation.
(4 Moisture on the printable surface may cause smearing.

4 Ifthe CD/DVD tray or the internal transparent compartment are accidentally printed on, immediately wipe off
the ink.

[d  Reprinting on the same CD/DVD may not improve the print quality.

4 Ifyou select CD/DVD Premium Surface as the Media Type setting in the printer driver and use a high quality
CD/DVD, you can create high quality CD/DVD labels.

[ Makesure youlet CDs and DVDs dry completely out of direct sunlight before using them or touching the printed
surface.

4 Ifthe printed surface is sticky even after it has dried, the color saturation level may be too high. In that case, lower
the level of the color saturation in Epson Print CD.

(d  If the ink smears, adjust the color saturation using Epson Print CD.
(4 Set the printable area to fit the printable area of the CD/DVD.

4  For details on the printable area, see the following section.
= “Printable area” on page 166

(1 Only one CD or DVD can be printed at a time. When the Copies setting is set to 2 or more, remove each CD or

DVD from the tray after it has been printed, and then place the next CD or DVD on the tray. Follow the on-screen
instructions.

Starting Epson Print CD

For Windows
(4 Double-click the Epson Print CD icon on the desktop.

4 For Windows 7 and Vista:
Click the start button, point to All Programs, click Epson Software, and then click Print CD.

For Windows XP:
Click Start, point to All Programs, point to Epson Software, then click Print CD.

For Mac OS X

Double-click the Applications folder on your Mac OS X hard drive, then double-click in turn on the Epson Software
and Print CD folders and finally double-click the Print CD icon.

Printing on a CD/DVD with a commercially available software package

When you print on a CD/DVD with a commercially available software package that supports CD/DVD printing, you
have to make the following settings.

52



User’s Guide

Printing
Size A4
Orientation Portrait
Source (Windows) CD/DVD
Type CD/DVD or CD/DVD Premium Surface
Tray type*! Epson Tray Type 2*2

*1 Needs to be specified depending on the software.

*2 The name varies depending on the software.

Product presets (for Windows only)

Printer driver presets make printing a snap. You can also create presets of your own.

Product settings for Windows

Access the printer settings.
= “Accessing the printer driver for Windows” on page 44

Selecta Printing Presets in the Shortcuts tab. Product settings are automatically set to the values displayed in the
pop-up window.

2-sided printing

Use the printer driver to print on both sides of the paper.

_ 1
.-

For Windows users:
Four types of 2-sided printing are available: automatic standard, automatic folded booklet, manual standard and
manual folded booklet.

For Mac OS X users:
Mac OS X supports automatic standard 2-sided printing only.

2-sided printing is only available for the following papers and sizes.

Paper Size

Plain paper Legal*, Letter, A4, B5, A5*, A6*
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Paper Size
Epson Bright White Ink Jet Paper A4
Epson Double-Sided Matte Paper A4

* Manual 2-sided printing only.

Note:

[ This feature is not available for rear paper feeding.

A This feature may not be available at some settings.

d  Manual 2-sided printing may not be available when the product is accessed over a network or is used as a shared
printer.

[ Iftheinkrunslow during automatic 2-sided printing, the product stops printing and the ink needs to be replaced. When
ink replacement is complete, the product starts printing again, but there may be some missing parts in your print. If this
happens, print again the page that has missing parts.

1  The loading capacity differs during 2-sided printing.
= “Selecting Paper” on page 20

[ Only use papers that are suitable for 2-sided printing. Otherwise, the printout quality may deteriorate.

A Depending on the paper and the amount of ink used to print text and images, ink may bleed through to the other side of
the paper.

[ The surface of the paper may be smeared during 2-sided printing.

Note for Windows:

1 Manual 2-sided printing is available only when EPSON Status Monitor 3 is enabled. To enable the status monitor,
access the printer driver and click the Maintenance tab followed by the Extended Settings button. In the Extended
Settings window, check the Enable EPSON Status Monitor 3 check box.

[ When automatic 2-sided printing is performed, printing may be slow depending on the combination of options selected
for Select Document Type in the Print Density Adjustment window and for Paper & Quality Options in the Advanced
window.

Note for Mac OS X:

When automatic 2-sided printing is performed, printing may be slow depending on the combination of options selected for
Document Type in the Two-sided Printing Settings and for Print Quality in the Print Settings.

Product settings for Windows

Access the printer settings.
= “Accessing the printer driver for Windows” on page 44

Choose the desired 2-sided printing option in the Page Layout tab. To print folded booklets, select Folded
Booklet.

Note:
When using automatic printing, make sure Auto is selected.
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Click Settings, and make the appropriate settings.

n Check the other settings and print.

Note:
[ When printing automatically, and if you are printing high-density data such as photos or graphs, we
recommend making the settings in the Print Density Adjustment window.

0 The actual binding margin may be different from the specified settings depending on your application.
Experiment with a few sheets to examine actual results before printing the entire job.

1 Manual 2-sided printing allows you to print the even-numbered pages first. When you print odd-numbered
pages, a blank sheet of paper is output at the end of the print job.

[ When you are printing manually, make sure that the ink is completely dry before reloading the paper.

Product settings for Mac OS X

Access the Print dialog box.
= “Accessing the printer driver for Mac OS X” on page 45

Make the appropriate settings in the Two-sided Printing Settings pane.

Check the other settings and print.

Note:
Ifyou are printing high-density data such as photos or graphs, we recommend adjusting Print Density and Increased
Ink Drying Time settings manually.

Fit to page printing

Lets you automatically enlarge or reduce the size of your document to fit the paper size selected in the printer driver.

Note:
This feature may not be available at some settings.
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Product settings for Windows

Access the printer settings.
= “Accessing the printer driver for Windows” on page 44

Select Reduce/Enlarge Document and By Output Paper Size in the Page Layout tab, and then select the size of
the paper you are using from the drop-down list.

Check the other settings and print.

Product settings for Mac OS X

Access the Print dialog box.
= “Accessing the printer driver for Mac OS X” on page 45

Choose Scale to fit paper size for Destination Paper Size in the Paper Handling pane, and then select the size of
the paper you are using from the pop-up menu.

Check the other settings and print.

Pages per sheet printing

Lets you use the printer driver to print two or four pages on a single sheet of paper.

Note:
This feature may not be available at some settings.

Product settings for Windows

1 Access the printer settings.
= “Accessing the printer driver for Windows” on page 44

Select Multi-Page and then select the Pages per Sheet in the Page Layout tab.
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Choose the desired number of pages and page order.

n Check the other settings and print.

Product settings for Mac OS X

Access the Print dialog box.
= “Accessing the printer driver for Mac OS X” on page 45

Select the desired number of Pages per Sheet and the Layout Direction (page order) in the Layout pane.

Check the other settings and print.

Sharing the Product for Printing

Setup for Windows

These instructions tell you how to set up your product so other users on the network can share it.

First you will set up the product as a shared printer on the computer directly connected to it. Then you will add the
product to each network computer that will access it.

Note:
A These instructions are for small networks only. To share the product on a large network, consult your network
administrator.

[ The screen shots in the following section are from Windows 7.

Setting up the product as a shared printer

Note:
A Toset up the product as a shared printer in Windows 7 or Vista, you will need an account with administrator privileges
and the password if you log on as a standard user.

A To set up the product as a shared printer in Windows XP, you must log on to a Computer Administrator account.

Follow the steps below on the computer that is connected directly to the product:
Windows 7:
Click the start button, select Devices and Printers.

Windows Vista:
Click the start button, select Control Panel, and then select Printer from the Hardware and Sound category.

57



User’s Guide

Printing

Windows XP:
Click Start and select Control Panel, and then select Printers and Faxes, from the Printers and Other
Hardware category.

Windows 7:
Right-click the icon for your product, click Printer properties, and then click Sharing. Then click the Change
Sharing Options button.

Windows Vista:

Right-click the icon for your product, and then click Sharing. Click the Change sharing options button and
then click Continue.

Windows XP:
Right-click the icon for your product, then click Sharing.

Select Share this printer, then type a Share name.

Note:
Do not use spaces or hyphens in the share name.

5 EPSON XXX)0000CKXKX Properties (m3m]
Color Management | Security | Version Information
General Sharing | Ports I Advanced

If you share this printer, only users on your network with a username
% and password for this computer can print to it. The printer will not
be available when the computer sleeps. To change these settings,

use the Metwork and Sharing Center.

[¥] Share this printer
Share name: | EPSON

[#] Render print jobs on client computers

Drivers
If this printer is shared with users running different versions of
Windows, you may want to install additional drivers, so that the
users do not have to find the print driver when they connect to the

shared printer.
Additional Drivers...

—
'[ 0K ]' Cancel || Aoply |
_

If you want to automatically download printer drivers for computers that are running different versions of
Windows, click Additional Drivers and select the environment and the operating systems of the other
computers. Click OK, then insert the product software disk.

n Click OK or Close (if you installed additional drivers).
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Adding the product to the other network computers

Follow these steps to add the product to each network computer that will access it.

Note:

Your product must be set up as a shared printer on the computer to which it is connected before you can access it from
another computer.

® “Setting up the product as a shared printer” on page 57

1

Windows 7:
Click the start button, select Devices and Printers.

Windows Vista:
Click the start button, select Control Panel, and then select Printer from the Hardware and Sound category.

Windows XP:
Click Start and select Control Panel, and then select Printers and Faxes, from the Printers and Other
Hardware category.

Windows 7 and Vista:
Click the Add a printer button.

Windows XP:
Click the Add a printer button. The Add Printer Wizard appears. Click the Next button.

Windows 7 and Vista:
Click Add a network, wireless or Bluetooth printer, and then click Next.

Windows XP:
Select A network printer, or a printer attached to another computer, then click Next.

=)

L) = Add Printer

What type of printer do you want to install?

{9 Add a local printer
Use this option enly if you don't have a USB printer. (Windows autematically installs USB printers
when you plug them in.)

< Add a netwark, wireless or Bluetooth printer
Make sure that your computer is connected to the network, or that your Bluetooth or wireless
printer is turned on.

Follow the on-screen instructions to select the product you want to use.
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Note:

Depending on the operating system and the configuration of the computer to which the product is connected, the Add Printer

Wizard may prompt you to install the printer driver from the product software disk. Click the Have Disk button and follow
the on-screen instructions.

Setup for Mac OS X

To setup your product on a Mac OS X network, use the Printer Sharing setting. See your Macintosh documentation for
details.
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Scanning

Let’s Try Scanning

Starting a Scan
Let’s scan a document to get used to the process.

Place your original on the scanner glass.
= “Placing Originals” on page 34

Start Epson Scan.

1 Windows:
Double-click the Epson Scan icon on the desktop.

(d MacOSX:

Select Applications > Epson Software > EPSON Scan.

Select Home Mode.
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n Select Text/Line Art as the Document Type setting.

Click Preview.

E Click Scan.

L'_]'
g EPSON Scan

tode:
’ Home Made V]

Diocument Type

‘ Text/Line At

Image Type

) Calor () Grayscale
Destination
() Screen/web @ Printer

{300

Resl

(@ Blackiwhite

(71 Other

™| dpi

[arget Size

Onainal

Image Adustments

Diescreening

|| Color Restoration
[ Image Dption()
(@) Test Erhancement
Auto Area Segmentation

[ Backlight Correction

|| Dust Removal

[ Brighthess. .. l
] s
I Lhurmbnail -
I Help ] I Configuration... ] I Cloge

Image Adjuztments

| Desciesning

[ Calr Restaration

[T Image O ption)

(@) Test Enhancement
Auto Area Segmentation

[ Backlight Correction

|| Dust Remaoyval

[ Brightness. .. l
Lj FPreview S Sean
[ Thumbnail
’ Help ] ’ Configuration... ] ’ Cloze ]
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Click OK.

g =
Leocation
| My Documenits

) Othes:  Desklop Browse

Filz Name [Prafiz + 3-digit numer]
Prefi img Start Mumber: o

Image Faienal
Type: [JPEG (:ipa) x| [ Opiioas..
Delals: Compression Level: [16]

codi d

Encoding Standas
Embed ICC Profile: ON

[T Dvesrie any fles with the sate name

| Dpen iage lolder sller searming
[ Shows fdd Page dislog after scanning.

C ok J) [ cowa | [ heb |

Your scanned image is saved.

Image Adjustment Features

Epson Scan offers a variety of settings for improving color, sharpness, contrast, and other aspects affecting image
quality.

See the Help for more details on Epson Scan.

Histogram Provides a graphical interface for adjusting highlight, shadow, and gamma levels individually.

Tone Correction
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Image Adjustment

Adjusts brightness and contrast and the balance of red, green, and blue colors in the overall
image.

Color Palette

Provides a graphical interface for adjusting mid-tone levels, such as skin tones, without affecting
the highlight and shadow areas of the image.

Unsharp Mask

Descreening

Removes rippled patterns (known as moiré) that can appear in subtly shaded image areas such as
skin tones.

Color Restoration
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Backlight Correction Removes shadows from photos that have too much background light.

Dust Removal

Text Enhancement Enhances text recognition when scanning text documents.
$ —r
Follors the mstructons | Follow the mstructions
Mg Projects Vou n » SCANNG Propects vou 1
Submg Probiems Sohmg Problems
B If vou have & problem y B If vou have a problem 1
oo e anlirucmrs  check b o s aodhaars chack b

Auto Area Segmentation Makes Black&White images clearer and text recognition more accurate by separating the text
from the graphics.

108 WU GTEEImai=r an D Ooe
e one of these sections for instre

HAE VUL LIFQGECLLERE GRLE LIIE AR

in tha i th

Chan Chan
Color Enhance Enhance a certain color. You can select from red, blue, or green.
| = -

- airt W Maintonance
» ' i e be
f LI 1 s W s

Techni: ol Specilicalions Tedhnical Specifications

" T LS 1 i -Fac< here for tech al dataly

Basic Scanning from the Control Panel

You can scan documents and send the scanned image from the product to a memory card or a connected computer.
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Note:
[ Ifyou want to scan your data to a memory card, insert a memory card first.
® “Inserting a Memory Card” on page 32

A Ifyou want to use the Scan to Cloud service, double-click the shortcut icon E on your desktop and check the Epson
Connect guide.

Place your original(s).
= “Placing Originals” on page 34

Enter Scan mode from the Home menu.

Select a scan menu item.

oo o —

= “Scan Mode” on page 101

If you select Scan to Memory Card, you can make scanning settings.
If you select Scan to PC, select your computer.

Press & to start scanning.

o

Your scanned image is saved.

Scan mode menu list

Refer to the section below for the Scan mode menu list.
= “Scan Mode” on page 101

Basic Scanning from Your Computer

Scanning in Full Auto Mode

Full Auto Modelets you scan quickly and easily, without selecting any settings or previewing your image. This mode is
useful when you need to scan your originals at 100% size.

Note:
A This mode is not available when the Automatic Document Feeder is installed.

4 See the Help for more details on Epson Scan.

Place your original(s).
Start Epson Scan.

= “Starting Epson Scan Driver” on page 82
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Select Full Auto Mode from the Mode list.

P )

+. EPSON Scan =
S TJ Mode:

gae® EPSON Scan [ Full duta Mods v|

To zcan in Full Auto Mode, position or load
ﬂ Scan the rnaterial pou want to scan, then click
Scan.

For Color Restoration and other optionz, click the
Customize button and then make the zettings.

Customize...

Show thiz dialog bow before nest zcan.

I@ Y'ou can change the zcan mode in the Mode lizt bo
¥/J at the top right of the window,
Cloze

Note:
If the Show this dialog box before next scan check box is cleared, Epson Scan starts scanning immediately without
displaying this screen. To return to this screen, click Cancel in the Scanning dialog box during scanning.
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n Click Scan. Epson Scan starts scanning in Full Auto Mode.

- Y

. EPSON Scan 23]

L‘ Y ade:
. EPSON Scan FrrTT—

Previews and document type recognition is in progress.

Pauze

Epson Scan previews each image, detects what type of original it is, and selects the scan settings automatically.

Your scanned image is saved.

Scanning in Home Mode

Home Modelets you customize some scanning settings and check the changes you have made in a preview image. This
mode is useful for basic scanning of photos and graphics.

Note:
A In Home Mode, you can only scan from the scanner glass.

A See the Help for more details on Epson Scan.

1 Place your original(s).
= “Scanner glass” on page 36
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2 Start Epson Scan.

Scanning

= “Starting Epson Scan Driver” on page 82

Select Home Mode from the Mode list.

ol oR o NS

P

. EPSOM Scan
L' T
E.u? EPSON Scan

(o] ® [

Mode:

[Hume taode v]
Docurnent Tupe
'ﬁ/ Photograph -
Image Type
@ Calar () Grayscale () Black&w/ hite
Deztination
) Socreenfweb @ F' (7 Other

300

Original

Image Adjustments

[7] Descreening
[7] Color Restoration

Irmage Optionfz)
(@ Text Enhancement
Auto Area Segmentation

[T] Backlight Carrection
[7] Dust Remayal

’ Brighthezs. . ]
d Prewview Scan
Thumbnail
’ Help ] ’ Configuration... ] ’ Cloze ]

Click Preview.
= “Previewing and Adjusting the Scan Area” on page 74

Click Scan.

Select the Document Type setting.

Select the Image Type setting.

69

Adjust the exposure, brightness, and other image quality settings.




User’s Guide

Scanning

E In the File Save Settings window, select the Type setting and then click OK.

Note:
If the Show this dialog box before next scan check box is cleared, Epson Scan starts scanning immediately without
displaying the File Save Settings window.

Your scanned image is saved.

Scanning in Office Mode

Office Mode lets you quickly scan text documents without previewing your image.

Note:
See the Help for more details on Epson Scan.

Place your original(s).

= “Placing Originals” on page 34

Note for the Automatic Document Feeder (ADF):
Do not load paper above the line just under the ¥ arrow mark on the ADF.

Start Epson Scan.

= “Starting Epson Scan Driver” on page 82
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Select Office Mode from the Mode list.
.. EPSON Scan o & =]
o Mode
Mode:
s EPSON Scan | Dffice Made -
Image Type
@ Color () Grayzcale () Black&white
Dreztination
Diocument Source: chu:ument Tahble -
Size: Letter(3.5 11 in.] -
Orientation: @ E‘
Reszolution: ann - dpi

Image Adjustments
[T Unsharp Mask
[ Image Option
(@ Text Enhancerment
Auto Area Segmentation

Colar Enhance: Red

Brightness:

Caontrast:

[7] Descreening

‘ ‘J Previgw ‘ ‘ é Scan ‘ ‘ ,@‘

T

’ Canfiguratior... ] ’

LCloze ]

Select the Image Type setting.

Select the Document Source setting.

Select the size of your original as the Size setting.

Click Scan.

BN EE B
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E In the File Save Settings window, select the Type setting and then click OK.

Note:
If the Show this dialog box before next scan check box is cleared, Epson Scan starts scanning immediately without
displaying the File Save Settings window.

Your scanned image is saved.

Scanning in Professional Mode

Professional Mode gives you total control of your scanning settings and lets you check the changes you have madeina
preview image. This mode is recommended for advanced users.

Note:
See the Help for more details on Epson Scan.

Place your original(s).

= “Placing Originals” on page 34

Start Epson Scan.

= “Starting Epson Scan Driver” on page 82
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Select Professional Mode from the Mode list.

<. EPSOMN Scan o] @ |3

bt ode:
F‘ 4 -? EPSON Sca n [Ml:'r:fessiu:unal Mode "]

Settings
Marme: Current Setting -
Original
Docurent Type: Reflective -
Diocument Source: Document Table -
Auto Exposure Type: Photo -
Drestination
Image Type: 24-bit Color -
Resolution: 200 v  dpi
Document Size: o 8E0[ H| 11.70||in.
Original
Adustments

‘u ‘ ‘ K ‘ ‘ ; ‘ Reszet
Unsharp Mask

[7] Descreening
[7] Color Restaration

[7] Backlight Corection

[T] Dust Remowal

‘d Breview ‘ ‘ ) Soan @‘

[7] Thumbnail
’ Help ] [ Configuration... ] ’ Cloze ]

Select the type of original(s) you are scanning as the Document Type setting.

Select the Document Source setting.

If you select Reflective as the Document Type setting, select Photo or Document as the Auto Exposure Type
setting.

oo S
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Select the Image Type setting.

Select an appropriate resolution for your original(s) as the Resolution setting.

Click Preview to preview your image(s). The Preview window opens and displays your image(s).
= “Previewing and Adjusting the Scan Area” on page 74

Note for the Automatic Document Feeder (ADF):

[ The ADF loads your first document page, and then Epson Scan prescans it and displays it in the Preview
window. The ADF then ejects your first page.
Place your first document page on top of the rest of the pages, and then load the entire document into the ADF.

d Do not load paper above the line just under the ¥ arrow mark on the ADF.

Select the size of the scanned image(s) as the Target Size setting if necessary. You can scan your images at their
original size, or you can reduce or enlarge their size by selecting Target Size.

Adjust the image quality if necessary.
= “Image Adjustment Features” on page 63

Note:
You can save the settings you make as a group of custom settings with a Name, and later apply these custom settings
when scanning. Your custom settings are also available in Epson Event Manager.

See the Help for more details on Epson Event Manager.

Click Scan.

In the File Save Settings window, select the Type setting and then click OK.

Note:
If the Show this dialog box before next scan check box is cleared, Epson Scan starts scanning immediately without
displaying the File Save Settings window.

Your scanned image is saved.

Previewing and Adjusting the Scan Area

Selecting a preview mode

Once you have selected your basic settings and resolution, you can preview your image and select or adjust the image
area in a Preview window. There are two types of preview.

(d Normal preview displays your previewed image(s) in their entirety. You can select the scan area and make any

image quality adjustments manually.

(d Thumbnail preview displays your previewed image(s) as thumbnail(s). Epson Scan automatically locates the

edges of your scan area, applies automatic exposure settings to the image(s), and rotates the image(s) if necessary.
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Note:
[ Some of the settings that you change after previewing an image are reset if you change the preview mode.

A Depending on your document type and the Epson Scan mode you are using, you may not be able to change the preview
type.

A Ifyoupreviewimage(s) without the Preview dialog displayed, image(s) are displayed in the default preview mode. If you
preview with the Preview dialog displayed, image(s) are displayed in the preview mode that was displayed just before
previewing.

1 To resize the Preview window, click and drag the corner of the Preview window.

A See the Help for more details on Epson Scan.

Creating a marquee

A marquee is a moving dotted line that appears on the edges of your preview image to indicate the scan area.
Do one of the following to draw a marquee.

[d To draw the marquee manually, position the pointer in the area where you want to place the corner of your
marquee and click. Drag the cross-hairs over the image to the opposite corner of the desired scan area.

4 To draw the marquee automatically, click the auto locate icon. You can only use this icon when you are
viewing a normal preview and you only have one document on the scanner glass.

[ To draw the marquee at a specified size, type in a new width and height in the Document Size setting.

4 For best results and image exposure, make sure all sides of the marquee are located inside the preview image. Do
not include any areas around the preview image in the marquee.

Adjusting a marquee

You can move the marquee and adjust its size. If you are viewing a normal preview, you can create multiple marquees
(up to 50) on each image to scan different image areas as separate scan files.

To move the marquee, position your cursor inside the marquee. The pointer becomes a hand. Click and
{:-r? drag the marquee to the desired location.
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To resize the marquee, position your cursor over the edge or corner of the marquee.

B _I_ ' The pointer becomes a straight or angled double-arrow. Click and drag the edge or corner to the desired
size.

To create additional marquees of the same size, click this icon.

To delete a marquee, click inside the marquee and click this icon.

To activate all marquees, click this icon.

Note:
0 To restrict the movement of the marquee to vertical or horizontal only, hold down the Shift key as you move the
marquee.

[ To restrict the size of the marquee to the current proportions, hold down the Shift key as you resize the marquee.

O Ifyoudraw multiple marquees, make sure you click All in the Preview window before you scan. Otherwise, only the area
inside the last marquee you drew will be scanned.

Various Types of Scanning

Scanning a Magazine

First of all, place your magazine and start Epson Scan.
= “Starting a Scan” on page 61

< EPSON Scan ==
|

_J EDQNN Cran g“‘?—|
— Lo hiode —

Document Type

2 ——?\.:f/ Magasne -

Image Type
& Coly ") Grayscale 17 Blackiwhite

Destnalion

" Screenfwfeb @ Pinler Other

Tanget Sige: Glmml X ]

Irnage Adjustments
[¥] Descreening
Color Restoration

| Image Dptions) 4

s S5

Llose
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Select Home Mode from the Mode list.

Select Magazine as the Document Type setting.

Click Preview.

Adjust the exposure, brightness, and other image quality settings.

HENE

See the Help for more details on Epson Scan.

Click Scan.

£l

[ File Save Settings ==

&) Other: Diesklop
File Name [Prefix + 3-digit number]
Prefic img Start Mumber o=
-‘ Type: [PoF (e =| |- gsiens..|
Vet Papet Sizs AL IRagE hae
Oriertation: Poclrat

Maegine [Lelt. TopH 0.00in . 0.0Cn.)
Page Numbar: Save File With All Pages
Comprezsion Level : Standard Compression

|71 Dweswaite any files vith the same name
[ Show this dialeg bow befoee nest sean
] Dpen image folder alter scarming

[¥] Showe fsdd Page: dialag after scanning.

ok ) [ caea ] [ B |

E Select PDF as the Type setting, and then click OK.

Your scanned image is saved.
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Scanning Multiple Documents to a PDF File

First of all, place your document and
= “Starting a Scan” on page 61

start Epson Scan.

| < EPSON Scan =2 e
1 ilz EDQMk Caam :Ml;:::smndlv[nds =
Seings
Hame: Curiert Selfng -
| Sawe
Onginal
Document Type: Rellective -
2 ——{)ocmerl Sowee Documert Tabls r)
Ao Exposuie Type: Fhato 1_r]
Diestination
Image Type: 240t Calon -
Resohtion: 300 > dpi
Document Size: W 850 H| 11.70||mn
Adjustments
) (] a @ 2] C=
ou | | | -
[# [V Unsharp Mask
[} [T Descrcening
|71 Colot Restoeation
[# [ Backlight Cosrechion
[#] [ Dust Removal
Uhmbed = =
[ e | [ conigusn. Cise

=5

Select Professional Mode from the Mode list.

2

B

Click Preview.

Select the Document Source setting.

Note for the Automatic Document Feeder (ADF):
A The document page ejected by the ADF has not been scanned yet. Reload the entire document into the ADF.

d Do not load paper above the line just under the ¥ arrow mark on the ADF.
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n Adjust the exposure, brightness, and other image quality settings.

See the Help for more details on Epson Scan.

Click Scan.

<. File Save Settings =
Lecation
I My Documents

yOehet:  Deshlop Bromise.
File Name [Prelix + 3-digil numier]
Erefic img Start Humbes: ok
RN <
-l I [FOECe®) ) .
Uetans: FApes e ACIUS IMage e
Oriertation: Portrat

Maegin: [Lelt. TopH 0,00in.. 0.0Cn.)
Page Number Save File With All Pages
Comprezzion Level : Standard Compression

[ Dwetwrite any files with the same name
I;‘ Show thiz dialog bow before next scan

%] Dpen image folder alter scanning

[#] Shows f4dd Page: dialag afler scanning.

E o] [ canca | [ Hep |

E Select PDF as the Type setting, and then click OK.

Note:
If the Show Add Page dialog after scanning check box is cleared, Epson Scan automatically saves your document
without displaying the Add Page Confirmation window.

Epson Scan starts scanning your document.

Add Page Confirmation
e, Scanning complete.
I@l Do you want to continue scanning and add more pages?

Select Edit Page to finish scanning and edit the pages
before zaving the file.

Select Save File ta finizh ecanning and save the file
without editing the pages.

8 : Add page | [I Edit page I ’ Save File ]]-- 9

E If you want to scan more pages, click Add page.
Load the document and scan again, repeating as necessary for each page.

If you have finished scanning, go to step 9.
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E Click Edit page or Save File.

Edit page

Select this button if you want to delete or reorder any of the pages. Then use the icons on the

bottom of the Editing Page window to select, rotate, reorder, and delete pages.

See the Help for more details on Epson Scan.

<. Edting Page

Tots Pages d

=

BER NV

Hele

Click OK when you are finished editing your pages.

Save File

Select this button when you are finished.

The pages are saved in one PDF file.
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Scanning a Photo

First of all, place your photo on the scanner glass and start Epson Scan.

= “Starting a Scan” on page 61

< EPSOM Scan ol ® &=
b Mode:

R e — S

Document Type
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[ beb | [ Cobonsbon. | [ ooe |

Click Preview.

HENE

Select Home Mode from the Mode list.

See the Help for more details on Epson Scan.

Select Photograph as the Document Type setting.

Adjust the exposure, brightness, and other image quality settings.
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Click Scan.

<. File Save Settings

Locatian

My Documeris
@ My Piclures
Other:  Desklop

File Name [Prefis + 3-digit number]

Prefic img Stari Mumber; oni
e I S
'{lvp-e'. |JPEG [*ipgl '| l Dplions..,

Uetais: Lompiession Lesel: [16]

Encoding Standard
Errbed ICC Profile: ON

|77 Dweiwie any files vath the same name
[] Shiow this disleg bow befoee nest scan
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[ Show fsdd Page dalag after scanning.

C_ox ] [ cancat | [ Help

E Select JPEG as the Type setting, and then click OK.

Your scanned image is saved.

Software Information

Starting Epson Scan Driver

This software lets you control all aspects of scanning. You can use this as a standalone scanning program or use it with
another TWAIN-compliant scanning program.

How to start

d  Windows:
Double-click the EPSON Scan icon on the desktop.
Or, select the start button icon or Start > All Programs or Programs > EPSON > EPSON Scan > EPSON
Scan.

d MacOSX:
Select Applications > Epson Software > EPSON Scan.

How to access the help

Click the Help button on the Epson Scan driver.
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Starting Other Scanning Software

Note:
Some scanning software may not be included in some countries.

Epson Event Manager

This lets you assign any of the product buttons to open a scanning program. You can also save frequently used
scanning settings, which can really speed up your scanning projects.

How to start

[ Windows:
Select the start button or Start > All Programs or Programs> Epson Software > Event Manager.

d MacOSX:
Select Applications > Epson Software, and then double-click the Launch Event Manager icon.

How to access the help

d  Windows:
Click the % icon in the upper right corner of the screen.

d MacOSX:
Click menu > Help > Epson Event Manager Help.

ABBYY FineReader

This software lets you scan a document and convert the text into data that you can edit with a word processing
program.

OCR software cannot recognize, or has difficulty recognizing, the following types of documents or text.
Handwritten characters
Items that have been copied from other copies

Faxes

0
o
o
d  Text with tightly spaced characters or line pitch
[ Text that is in tables or underlined

4 Cursive or italic fonts, and font sizes less than 8 points
0

Folded or wrinkled documents

See the ABBYY FineReader help for more details.

How to start

d  Windows:
Select the start button or Start > All Programs or Programs > ABBYY FineReader folder > ABBYY
FineReader.
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d MacOSX:
Select Applications, and then double-click ABBYY FineReader.

Presto! PageManager
This software lets you scan, manage, and share your photos or documents.

How to start

d  Windows:
Select the start button or Start > All Programs or Programs > Presto! PageManager folder > Presto!
PageManager.

d MacOSX:
Select Application > Presto! PageManager, and then double-click the Presto! PageManager icon.
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Faxing

Note:
The Fax function is only available for XP-850.

Introducing FAX Utility

FAX Utility is a software capable of transmitting data such as documents, drawings, and tables created using a word
processing or spreadsheet application directly by fax, without printing. Use the following procedure to run the utility.

Windows
Click the start button (Windows 7 and Vista) or click Start (Windows XP), point to All Programs, select Epson
Software, and then click FAX Utility.

MacOS X

Click System Preference, click Print & Fax or Print & Scan, and then select FAX (your product) from Printer. Then
click as follows;

Mac OS X 10.6.x, 10.7.x: Option & Supplies - Utility - Open Printer Utility

Mac OS X 10.5.x: Open Print Queue - Utility

Note:
For more details, see the online help for FAX Utility.

Connecting to a Phone Line

About a phone cable

Use a phone cable with the following interface specification.
(1 RJ-11 Phone Line

4 RJ-11 Telephone set connection

Depending on the area, a phone cable may be included with the product. If so, use that cable.
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Using the phone line for fax only

Connect a phone cable leading from a telephone wall jack to the LINE port.

@ .. LINE

2 Make sure Auto Answer is set to On.
= “Setting up to receive faxes automatically” on page 94

Important:
Ifyou do not connect an external telephone to the product, make sure you turn on auto answer. Otherwise, you cannot

receive faxes.

Sharing line with phone device

Connect a phone cable leading from a telephone wall jack to the LINE port.

@ ., LINE

Remove the cap.

LINE

((
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Connect a phone or answering machine to the EXT. port.

Note:
A See the following for other connection methods.

A For details, see the documentation that came with your devices.

Connecting to DSL
a Telephone wall jack
b Splitter
c DSL modem

Connecting to ISDN (one phone number)

d ISDN wall jack

e Terminal adapter or ISDN router
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Connecting to ISDN (two phone numbers)

—

d ISDN wall jack

e Terminal adapter or ISDN router

Checking the fax connection
You can check whether the product is ready to send or receive faxes.

Load A4-size plain paper in the cassette.
= “Loading Paper” on page 24

Enter Setup mode from the Home menu.
Select Fax Settings.
Select Check Fax Connection.

Press & to print the report.

Bl EAN R

Note:
If an errors are reported, try the solutions in the report.

Notices when the power is turned off

When the product is turned off, the following data stored in the product’s temporary memory is erased.
[d  Received fax data

[d  Fax data scheduled to be sent later

[d Fax data being transmitted automatically

Also, when the power is left off for an extended period of time, the clock may be reset. Check the clock when you turn
the power back on.
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If the product is turned off due to a power failure, it automatically restarts and beeps when the power is restored. If you
have set to receive faxes automatically (Auto Answer - On), the setting is also restored. Depending on the
circumstances before the power failure, it may not restart.

Setting Up Fax Features

Setting up speed dial entries

You can create a speed dial list allowing you to select fax recipient numbers quickly when faxing. Up to 60 combined
speed dial and group dial entries can be registered.

Enter Fax mode from the Home menu.

Press Contacts.

Select Add/Edit Contacts.

Select Speed Dial Setup. You see the available speed dial entry numbers.

Select the speed dial entry number that you want to register. You can register up to 60 entries.

Enter a phone number. You can enter up to 64 digits.

BB EDNR

Note:
A hyphen ("-") causes a slight pause when dialing. Only include it in phone numbers when a pause is necessary.
Spaces entered between numbers are ignored when dialing.

Select Done.

E Enter a name to identify the speed dial entry. You can enter up to 30 characters.

E Select Done to register the name.

Setting up group dial entries

You can add speed dial entries to a group, allowing you to send a fax to multiple recipients at the same time. Up to 60
combined speed dial and group dial entries can be entered.

Enter Fax mode from the Home menu.
Select Contacts.
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Select Edit Contacts.

Select Group Dial Setup. You see the available group dial entry numbers.

Select the group dial entry number that you want to register.

Enter a name to identify the group dial entry. You can enter up to 30 characters.

Select Done to register the name.

Select the speed dial entry number that you want to register in the group dial list.

Repeat step 8 to add other speed dial entries to the group dial list. You can register up to 30 speed dial entriesina
group dial.

Select Done to finish creating a group dial list.

H OCOENEEREAEBRNMEA

Creating header information

You can create a fax header by adding information such as your phone number or name.

Note:
Make sure you have set the time correctly.
® “Setting/Changing Time and Region” on page 123

Enter Setup mode from the Home menu.

Select Fax Settings.

Select Communication.

Select Header.

Select Fax Header.

Enter the header information. You can enter up to 40 characters.

Select Done.

~goog~RoEoN—
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Select Your Phone Number.

E Enter your phone number. You can enter up to 20 digits.

Note:
Press the # button to enter a plus sign (+) which represents the international call prefix. Note that the asterisk (*) is
unavailable.

Select Done to register the header information.

Sending Faxes

Sending faxes by entering a number

Place your original in the Automatic Document Feeder or on the scanner glass.
= “Placing Originals” on page 34

Enter Fax mode from the Home menu.
Touch the Enter Fax Number area on the LCD screen.

Enter the fax number, and then select Done. You can enter up to 64 digits.

OEaN B

Note:
[  Todisplay the last fax number you used, press Redial.

A Make sure you have entered the header information. Some fax machines automatically reject incoming faxes
that do not include header information.

Press ¥, select Color or B&W, and then change the other settings if necessary.

E Press & to start sending.

Note:
Ifthe fax number is busy or there is some problem, this product redials after one minute. Press Redial to redial immediately.

Sending faxes using speed dial/group dial

Follow the instructions below to send faxes using speed dial/group dial.
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Note:
When using group dial, you can only send B&W faxes.

Place your original in the Automatic Document Feeder or on the scanner glass.
= “Placing Originals” on page 34

Enter Fax mode from the Home menu.

Press Contacts.

Select the entry number to send.

Press ¥, select Color or B&W, and then change the other settings if necessary.

BN EAN R

Note:
To scan and fax both sides of your original, load the original in the ADF, and then select 2-Sided Faxing - On.

E Press < to start sending.

Sending faxes by broadcasting

Broadcast allows you to easily send the same fax to multiple numbers (up to 30) using speed dial/group dial, or by
entering the fax numbers. Follow the instructions below to send faxes by broadcasting.

Note:
You can only send Be&»W faxes.

Place your original in the Automatic Document Feeder or on the scanner glass.
= “Placing Originals” on page 34

Enter Fax mode from the Home menu.

Select Advanced Options.

Select Broadcast Fax.

HEaNE

Note:
To select recipients from a speed or group dial list, go to step 8.

Select Add New.

el
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Select Enter Fax Number.

Enter a fax number, and then select Done.

N

Note:
A To add another number, repeat steps 5 through 7.

0 Ifyou do not need to add recipients from the speed dial/group dial lists, select Done, and then go to step 13.

Select Add New.

Select Select from Contacts.

Select the entry number.

Select Done.

Select Done.

Press < to start sending.

HNHBEHEEAEER

Sending a fax at a specified time

Follow the instructions below to send a fax at a specified time.

Note:
d  Make sure you have set the time correctly.
= “Setting/Changing Time and Region” on page 123

1 You can only send B&W faxes.

Place your original in the Automatic Document Feeder or on the scanner glass.
= “Placing Originals” on page 34

Enter Fax mode from the Home menu.

Enter a fax number. You can also use redial, speed dial, or group dial lists to select fax numbers.

Select Advanced Options.

Select Send Fax Later.

Bl EANER
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E Select On.

Set the time that you want to send the fax, and then select Done.

E Press ® to start scanning. The scanned image is sent at the specified time.

Note:
If you need to cancel faxing at the time you specified, press @.

Sending a fax from a connected phone

If the recipient has the same number for both phone and fax, you can send a fax after talking over the phone without
hanging up.

1 Place your original in the Automatic Document Feeder or on the scanner glass.
= “Placing Originals” on page 34

Dial a number from the phone connected to the product.

Select Send on the control panel of the product.
Press & to send fax.

Hang up the phone.

5

Receiving Faxes

Setting up to receive faxes automatically

Follow the steps below to make settings to receive faxes automatically.
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Load A4-size plain paper in the cassette.
= “Loading Paper” on page 24

Make sure Auto Answer is set to On.
Setup > Fax Settings > Receive Settings > Auto Answer > On

N =2

Note:
1 When an answering machine is connected directly to this product, make sure you set Rings to Answer correctly
using the following procedure.

A Depending on the region, Rings to Answer may be unavailable.

Enter Setup mode from the Home menu.

Select Fax Settings.

Select Communication.

Select Rings to Answer.

Press + or - to select the number of rings, and then select Done.

~Hools R

Important:
Select more rings than needed for the answering machine to pick up. If it is set to pick up on the fourth ring, set the
product to pick up on the fifth ring or later. Otherwise the answering machine cannot receive voice calls.

Note:

When you receive a call and the other party is a fax, the product receives the fax automatically even if the answering machine
picks up the call. If you pick up the phone, wait until the LCD screen displays a message saying that a connection has been
made before you hang up. If the other party is a caller, the phone can be used as normal or a message can be left on the
answering machine.

Receiving faxes manually

If your phone is connected to the product, and Auto Answer mode has been set to Off, you can receive fax data after the
connection is made.

1 Load A4-size plain paper in the cassette.
= “Loading Paper” on page 24
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When the telephone rings, lift the phone connected to the product.

When you hear a fax tone, select Receive.

n Press & to receive the fax, and then put the phone back on the hook.

Press < to print your faxes.

Receive a fax by polling

This allows you to receive a fax from the fax information service you have called.

Follow the instructions below to receive a fax by polling.

Load A4-size plain paper in the cassette.
= “Loading Paper” on page 24

Enter Fax mode from the Home menu.
Select Advanced Options.

Select Polling, and then select On.
Enter the fax number.

Press < to receive the fax.

Press < to print the received fax.

~Hool~ RN~

Printing Reports

Follow the instructions below to print a fax report.

1 Load A4-size plain paper in the cassette.
= “Loading Paper” on page 24
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Enter Fax mode from the Home menu.

Select Advanced Options.

Select Fax Report.

Select the item you want to print.

BN AN

Note:
Only Fax Log can be viewed on the screen.

E Press & to print the report you selected.

Fax Mode Menu List

Refer to the section below for the Fax mode menu list.
= “Fax Mode” on page 102
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More Functions

More Functions provides you with many special menus that make printing easy and fun! For more details, select More
Functions, select each menu, and then follow the instructions on the LCD screen.

Menu Functions

You can make faithful copies of your originals.
If your original photo is faded, you can restore
color to bring it back to life.

Copy/Restore Photos

Photo Layout Sheet You can print your photos onamemory card in

various layouts.

You can create custom cards with handwritten
messages by using an A4 template. First printa
template, write your message, and then scan
the template to print your cards.

Greeting Card

Copy to CD/DVD You can copy your photo or CD/DVD label onto
a CD/DVD label. The image is automatically

cropped and resized to fit the CD/DVD label.

Print on CD/DVD You can create CD/DVD labels from photos on

a memory card without using a computer.
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Menu Functions

Print Ruled Papers You can print ruled paper or graph paper with

or without a photo set as the background.

Coloring Book* S You can create a coloring sheet from your
photos or line drawings.
; y-

X

*Only use the Coloring Book function for drawings and pictures that you created yourself. When using copyrighted materials, make
sure you stay within the range of laws governing printing for personal use.
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Menu List of Control Panel

You can use this product as a printer, copier, scanner, and fax. When using one of these functions, except the printer
function, select your desired function by pressing the corresponding Mode button on the control panel. Each mode’s
main screen appears as you select the mode.

Copy Mode

Note:
Depending on the model, some functions may not be available.

Menu

Setting and Options

2-Sided Copying

1>1-Sided, 2>2-Sided, 1>2-Sided, 2>1-Sided

Layout

With Border, Borderless*, A4, 2-up Copy, A4, Book/2-up, Book/2-Sided

Reduce/Enlarge

Custom Size, Actual Size, Auto Fit Page, 10x15cm->A4, A4->10x15cm,
13x18->10x15, 10x15->13x18, A5->A4, A4->A5

Paper Size

A4, A5, 10x15cm(4x6 in), 13x18cm(5x7 in)

Paper Type

Plain Paper, Matte, Prem. Glossy, Ultra Glossy, Glossy, Photo Paper

Paper Source

Cassette 1, Cassette 2

Document Type

Text, Text & Image, Photo

Quality

Draft, Standard Quality, Best

Document Orientation

Portrait, Landscape

Binding Direction

Left, Top

Binding Margin

Left, Top

Expansion

Standard, Medium, Minimum

Dry Time

Standard, Long, Longer

Clear All Settings

Yourimage s slightly enlarged and cropped to fill the sheet of paper. Print quality may decline in the top and bottom areas of the

printout, or the area may be smeared when printing.

Print Photos Mode

Note:

Depending on the model, some functions may not be available.
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Menu Setting and Options

Select Photos Select All Photos

Select by Date

Cancel Photo Selection

Select Location Select Folder

Select Group

Print Settings Paper Size 10x15cm(4x6in), 13x18cm(5x7in), 16:9 wide, A4,

100x148mm

Paper Type Prem. Glossy, Ultra Glossy, Glossy, Photo Paper, Plain
Paper, Matte, Photo Sticker

Paper Source Cassette 1, Cassette 2, Cassette 1>Cassette 2, Rear
Paper Feed Slot

Borderless Borderless*, With Border

Quality Draft, Standard Quality, Best

Expansion Standard, Medium, Minimum

Date Off, yyyy.mm.dd, mm.dd.yyyy, dd.mm.yyyy

Print Info. On Photos Off, Camera Settings, Camera Text, Landmark

Fit Frame On, Off

Bidirectional On, Off

Clear All Settings

Edit Photos Photo Adjustments Enhance, Scene Detection, Fix Red-Eye, Filter,
Brightness, Contrast, Sharpness, Saturation

Crop/Zoom

* Yourimage s slightly enlarged and cropped to fill the sheet of paper. Print quality may decline in the top and bottom areas of the
printout, or the area may be smeared when printing.

Scan Mode

Note:
Depending on the model, some functions may not be available.
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Menu

Settings and Options

Scan to Memory Card

2-Sided Scanning

Off, On

Scan Area A4, Auto Cropping, Max Area
Document Text, Photograph

Resolution 200dpi, 300dpi, 600dpi
Contrast -4to +4

Document Orientation

Portrait, Landscape

Scan to PC (Email)

Binding Direction Left, Top
Clear All Settings
Scan to Cloud™
Scan to PC 2-Sided Scanning Off, On
Scan to PC (PDF)

Scan to PC (WSD)*2

*1 For instructions on Scan to Cloud, see the Epson Connect guide.

= “Using Epson Connect Service” on page 9

*2 Available for computers running English versions of Windows 7 or Vista.

Fax Mode

Note:

These functions are available only for Fax capable models.

Menu Description
Resolution Select this option to change the resolution for fax data you are sending.
Contrast Select this option to change the contrast for fax data you are sending.

2-Sided Faxing

Turn on when sending 2-sided originals in the ADF.

Clear All Settings

Send Fax Later

= See “Sending a fax at a specified time” on
page 93

Broadcast Fax

= See “Sending faxes by broadcasting” on page 92

Polling

= See “Receive a fax by polling” on page 96
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Menu Description

Fax Report Fax Log

Prints or displays the communication log.

Last Transmission

Prints a communication-in log for the previous
transmission or the previous polling results received.

Contact List

Prints the Contact list.

Speed Dial List

Prints the speed dial list.

Group Dial List

Prints the group dial list.

Reprint Faxes

Reprints from the latest fax received. When the
memory is full, the oldest faxes are erased first.

Protocol Trace

Prints the protocol for the latest communication.

More Functions Mode

Note:
Depending on the model, some functions may not be available.

Menu Setting and Options
Copy/Restore Photos™ Off, On
Paper and Copy Settings Paper Size, Paper Type, Paper Source, Borderless 2,
Expansion
Photo Adjustments Enhance, Filter
Crop/Zoom
Photo Layout Sheet™ 2-up, 4-up, 8-up, 20-up, Sticker 16-up, Upper 1/2, Lower 1/2, Photo ID, Jewel Upper, Jewel Index,
P.L.F.
Paper Size 10x15cm(4x6in), 13x18cm(5x7in), 16:9 wide, A4, A6,
100x148mm
Paper Type Prem. Glossy, Ultra Glossy, Glossy, Photo Paper, Plain

Paper, Matte, Photo Sticker, PhotoSticker16

Automatic layout, Place photos manually

Select Photos

Select All Photos, Select by Date, Cancel Photo
Selection

Photo Adjustments

Enhance, Scene Detection, Fix Red-Eye, Filter,
Brightness, Contrast, Sharpness, Saturation

Crop/Zoom

Print Settings

Quality, Expansion, Date, Print Info. On Photos, Fit
Frame, Bidirectional, Paper Source
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Menu Setting and Options
Greeting Card"! Select Location Select Folder, Select Group
Photo Adjustments Enhance, Scene Detection, Fix Red-Eye, Filter,
Brightness, Contrast, Sharpness, Saturation
Paper Size 10x15cm(4x6in)
Paper Type Prem. Glossy, Ultra Glossy, Glossy, Photo Paper
Layout Borderless™2, Upper 1/2, Lower 1/2
Frame Off, Oval, Oval - Soft Edge
Copy to CD/DVD™! Document Type Text&mage, Photo
Quality Standard Quality, Best
Print on CD/DVD™! Print Layout CD/DVD 1-up, CD/DVD 4-up, CD/DVD Variety
Select Location Select Folder, Select Group
Photo Adjustments Enhance, Scene Detection, Fix Red-Eye, Filter,
Brightness, Sharpness, Saturation
Crop/Zoom
Print Settings CD Density
Print Ruled Papers Wide Rule Only, Thin Rule Only, Graph Paper Only, Watermark without Rule, Watermark Horizontal
Rule, Watermark Vertical Rule
Coloring Book Print Settings Paper Settings, Paper Source, Density, Line Detection

*1 The menu hierarchy varies depending on the product.

*2 Yourimage is slightly enlarged and cropped to fill the sheet of paper. Print quality may decline in the top and bottom areas of the
printout, or the area may be smeared when printing.

Wi-Fi Setup Mode

Note:
Depending on the model, some functions may not be available.
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Menu

Setting and Options

Wi-Fi Auto Connect

Wi-Fi Setup Wizard

Push Button Setup (WPS)

PIN Code Setup (WPS)

Wi-Fi Direct Connection
Setup

Wi-Fi/Network Status

Disable Wi-Fi

For details on the setting items, see the online Network Guide.

Setup Mode

Note:

Depending on the model, some functions may not be available.

Menu Setting Item Description
Ink Levels - Checks the status of ink cartridges.
Maintenance Nozzle Check Prints anozzle check pattern to check the condition of

the print head.

Head Cleaning

Cleans the print head to improve the condition of the
print head.

Print Head Alignment

Adjusts the alignment of the print head.

Ink Cartridge Replacement

Replaces ink cartridges.

Printer Setup

CD/DVD Adjusts the print position.

Stickers Adjusts the print position.

Thick Paper Turn on when printing on thick paper.

Sound Button Press, Error Notification, Completion Notice,

Volume

Screen Saver

Off, Memory Card Data

Power Off Timer

Sleep Timer

= See “Using the control panel” on page 119

Clear All Settings
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Menu

Setting Item

Description

Basic Setup

Date/Time

= See “Setting/Changing Time and Region” on
page 123

Daylight Saving Time

Off, On

Country/Region

= See “Setting/Changing Time and Region” on
page 123

Language

Wi-Fi/Network Settings

Wi-Fi Setup

Manual Wi-Fi/Network Setup

See the online Network Guide. You can access the
Wi-Fi Setup menus directly by selecting Wi-Fi Setup
on the LCD screen.

Wi-Fi/Network Connection Check

You can check the network connection status, and
print the report. If there is any problem with the
connection, the report helps you find the solution.

Wi-Fi/Network Status

You can see the current network settings and print a
network status sheet.

Epson Connect Services

Google Cloud Print
Services

For instructions on how to use these menus, see the Epson Connect guide.
= “Using Epson Connect Service” on page 9

File Sharing Setup

For details on the setting items, see the online Network Guide.

Home NW Print Settings

Print Settings

Paper Size, Paper Type, Paper Source, Quality,
Bidirectional, CD Inner/Outer, CD Density, Clear All
Settings

Photo Adjustments

Enhance, Scene Detection, Fix Red-Eye, Filter,
Brightness, Contrast, Sharpness, Saturation, Clear All
Settings
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Menu

Setting Item

Description

Fax Settings

Send Settings

Resolution: Select this option to change the
resolution for fax data you are sending.

Contrast: Select this option to change the contrastfor
fax data you are sending.

2-Sided Faxing: Turn on when sending 2-sided
originals in the ADF.

Last Transmission Report: Indicates whether or
when the product prints a report for outgoing faxes.
Select Off to turn off report printing, select On Error
to print reports only when an error occurs, or select
On Send to print reports for every fax you send.

Receive Settings

Auto Answer: Turn on to receive faxes automatically.

Auto Reduction: Indicates whether large received
faxes are reduced in size to fit on A4-size, or printed at
their original size on multiple sheets.

Communication

DRD: Indicates the type of answer ring pattern you
want to use to receive faxes. To select an option other
than All (or Off), you must set up your phone system
to use different ring patterns. This option may be On
or Off depending on the region.

ECM: Indicates whether or not to use Error Correction
Mode to automatically correct fax data sent/received
with errors due to the line or any other problems.

Color faxes cannot be sent/received when ECM is off.

Fax Speed: Indicates the speed at which you transmit
and receive faxes.

Rings to Answer: Indicates the number of rings that
must occur before the product automatically receives
a fax. Depending on the region, this setting may not
be displayed.

Dial Tone Detection: When this is set to On, the
product starts dialing after it detects adial tone.lt may
not be able to detect a dial tone when a PBX (Private
Branch Exchange) or a TA (Terminal Adapter) is
connected. In that case, set to Off. However, doing so
may drop the first digit of a fax number and send the
fax to the wrong number.

Dial Mode: Indicates the type of phone system to
which you have connected the product. Depending
on the region, this setting may not be displayed.

Header: ® See “Creating header information” on
page 90

Check Fax Connection

Checks the status of your fax connection.

External Device Setup

Print Settings

Paper Size, Paper Type, Paper Source, Layout, Quality,
Expansion, Date, Print Info. On Photos, Fit Frame,
Bidirectional, CD Inner/Outer, CD Density, Clear All
Settings

Photo Adjustments

Enhance, Scene Detection, Fix Red-Eye, Filter,
Brightness, Contrast, Sharpness, Saturation, Clear All
Settings
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Menu Setting Item Description
Guide Functions Paper Size Alert On, Off
Document Alert On, Off

Auto Selection Mode

Memory Card, Document Cover, Auto Document
Feeder

All Functions

On, Off

Clear All Settings

Restore Default Settings

Fax Send/Receive Settings

Initializes Fax Send/Receive settings to the factory
default settings.

Fax Data Settings

Initializes Fax Data settings to the factory default
settings.

Wi-Fi/Network Settings

Initializes Wi-Fi/Network settings to the factory
default settings.

All except Wi-Fi/Network Settings

Initializes all settings except for Wi-Fi/Network
settings to the factory default settings.

All except Wi-Fi/Network & Fax Settings

Initializes all settings except for Wi-Fi/Network & Fax
settings to the factory default settings.

All Settings

Initializes all settings to the factory default settings.

Help Mode

Note:

Depending on the model, some functions may not be available.

Menu

Options

Howto...

Navigate Using the Touch Screen

Load Paper in the Rear Paper Feed Slot

Load Paper in the Paper Cassette

Load an Envelope in the Rear Paper Feed Slot

Load Envelopes in the Paper Cassette

Load a CD/DVD

Place a Document in the ADF

Place a Document on the Scanner Glass

Insert/Remove a Memory Card/USB Flash Drive

Adjust the Angle of the Control Panel
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Menu Options

Ink Cartridges Check Ink Cartridge Status

Replace Ink Cartridges

Troubleshooting Cannot Connect to a Wi-Fi

Paper Feeding Incorrectly

Poor Print Quality

Cannot Send or Receive Fax

Cannot Scan to PC

Icon List
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Replacing Ink Cartridges

Ink Cartridge Safety Instructions, Precautions, and
Specifications

Safety instructions

Observe the following when handling the ink cartridges:

4

4

Keep ink cartridges out of the reach of children.

Be careful when you handle used ink cartridges, as there may be some ink around the ink supply port.

If ink gets on your skin, wash the area thoroughly with soap and water.

If ink gets into your eyes, flush them immediately with water. If discomfort or vision problems continue after a
thorough flushing, see a doctor immediately.

If ink gets into your mouth, spit it out immediately and see a doctor right away.

If youremove the cartridge from the product for later use or to dispose of it, make sure you put the cap back on the
cartridge’s ink supply port to prevent ink from drying out or to prevent surrounding areas from getting smeared
by ink.

Do not push hard or squeeze the ink cartridges, or be careful not to drop them. Doing so may cause ink leakage.

Do not disassemble or remodel the ink cartridge, otherwise you may not be able to print normally.

Do not touch the sections shown in the illustration. Doing so may prevent normal operation and printing.

[d Do not leave the product with the ink cartridges removed or do not turn off the product during cartridge

replacement. Otherwise, ink remaining in the print head nozzles will dry out and you may not be able to print.

Precautions on ink cartridge replacement

Read all of the instructions in this section before replacing the ink cartridges.

[d Epson recommends the use of genuine Epson ink cartridges. Epson cannot guarantee the quality or reliability of

non-genuine ink. The use of non-genuine ink may cause damage that is not covered by Epson’s warranties, and
under certain circumstances, may cause erratic product behavior. Information about non-genuine ink levels may
not be displayed.
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Do not shake ink cartridges too vigorously; otherwise ink may leak from the cartridge.

This product uses ink cartridges equipped with an IC chip that monitors information such as the amount of
remaining ink for each cartridge. This means that even if the cartridge is removed from the product before it is
expended, you can still use the cartridge after reinserting it back into the product. However, when reinserting a

cartridge, some ink may be consumed to guarantee product performance.

To maintain optimum printhead performance, some inkis consumed from all cartridges not only during printing
but also during maintenance operations such as ink cartridge replacement and print head cleaning.

Be careful not to let dust or any objects get inside the ink cartridge holder. Anything inside the holder may
adversely affect the printing results or result in an inability to print.

For maximum ink efficiency, only remove an ink cartridge when you are ready to replace it. Ink cartridges with
low ink status may not be used when reinserted.

Do not open the ink cartridge package until you are ready to install it in the product. The cartridge is vacuum
packed to maintain its reliability. If you leave a cartridge unpacked for a long time before using it, normal printing
may not be possible.

Install all ink cartridges; otherwise, you cannot print.

If an ink cartridge is running low, prepare a new ink cartridge.

After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature for at least
three hours before using it.

Store ink cartridges in a cool, dark place.

You cannot use the cartridges that came with your product for the replacement.

Ink Cartridge Specifications

4

N

Epson recommends using the ink cartridge before the date printed on the package.
The ink cartridges packaged with your product are partly used during initial setup. In order to produce high
quality printouts, the print head in your product will be fully charged with ink. This one-off process consumes a

quantity of ink and therefore these cartridges may print fewer pages compared to subsequent ink cartridges.

Quoted yields may vary depending on the images that you are printing, the paper type that you are using, the
frequency of your prints and environmental conditions such as temperature.

To ensure you receive premium print quality and to help protect your print head, a variable ink safety reserve
remains in the cartridge when your product indicates to replace the cartridge. The yields quoted for you do not
include this reserve.

Although the ink cartridges may contain recycled materials, this does not affect product function or performance.

When printing in monochrome or grayscale, color inks instead of black ink may be used depending on the paper
type or print quality settings. This is because a mixture of color inks is used to create black.
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Checking the Ink Cartridge Status

For Windows

Note:
A Epson cannot guarantee the quality or reliability of non-genuine ink. If non-genuine ink cartridges are installed, the ink
cartridge status may not be displayed.

A When an ink cartridge is running low, the Low Ink Reminder screen automatically appears. You can also check the ink
cartridge status from this screen. If you do not want to display this screen, first access the printer driver and then click the
Maintenance tab, the Extended Settings button, and then the Monitoring Preferences button. On the Monitoring
Preferences screen, clear the See Low Ink Reminder alerts check box.

A Ifan ink cartridge is running low, prepare a new ink cartridge.

To check the ink cartridge status, do one of the following:

4 Double-click the product shortcut icon on your Windows taskbar. To add a shortcut icon to the taskbar, see the
following section:
= “From the shortcut icon on the taskbar” on page 45

[ Open the printer driver, click the Maintenance tab, then click the EPSON Status Monitor 3 button. A graphic
displays the ink cartridge status.

LT EPSON Status Monitor 3 : EPSON X000 =
EPSON "%
Itis ready to print. -
Technical Support
Ink Levels
Elack Light Cyan Magenta Cyan Yieldow Light Magenta
A0, R, XK bt g XXX XXX
Information
(o ) e |

Note:
d  If EPSON Status Monitor 3 does not appear, access the printer driver and click the Maintenance tab and then the
Extended Settings button. In the Extended Settings window, check the Enable EPSON Status Monitor 3 check box.

A The ink levels displayed are an approximate indication.
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For Mac OS X

Note:
If an ink cartridge is running low, prepare a new ink cartridge.

You can check the ink cartridge status using EPSON Status Monitor. Follow the steps below.

1 Access the Epson Printer Utility 4.
= “Accessing the printer driver for Mac OS X” on page 45

Click the EPSON Status Monitor icon. The EPSON Status Monitor appears.

800 Epson Printer Utility 4

&

Buy Epson Ink

EPSON Epson xxxxx

% EPSOMN Status Monitor

Ink Levels
Light Cyae Magreis Fedlzw Lighs Magerny
000K, 00K 000K X000k e e
Information |

[ Update | | OK

Note:
0 Thegraphic displays the ink cartridge status when EPSON Status Monitor was first opened. To update the ink cartridge

status, click Update.

0 Epson cannot guarantee the quality or reliability of non-genuine ink. If non-genuine ink cartridges are installed, the ink
cartridge status may not be displayed.

A The ink levels displayed are an approximate indication.

Using the control panel

Enter Setup mode from the Home menu.

Select Ink Levels.
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Note:
The ink levels displayed are an approximate indication.

Conserving Black Ink When the Cartridge is Low (For
Windows Only)

The window below appears when black ink runs low and there is more color ink than black ink. It appears only when
plain papers is selected as the paper type, and Text is selected as the Quality Option.

EPSOMN Status Monitor 3

Black ink iz lowe. Y'ou can extend black ink catndge life by printing with a
mixture of other calors to creale composite black.
Do pou want bo do this fior the current pant job?

E Yes ;

| No |

[ Disable this feature |

The window gives you the option to either continue using black ink normally or conserve black ink by using a mixture
of color inks to create black.

4 Click the Yes button to use a mixture of color inks to create black. The same window is displayed the next time you
print a similar job.

4 Click the No button to continue using the remaining black ink for the job you are printing. You will see the same
window the next time you print a similar job, and again have the option to conserve black ink.

4 Click Disable this feature to continue using the remaining black ink.

Replacing an ink cartridge

Note:
O Make sure that the CD/DVD tray is not inserted in the product and that the O light is on, but not flashing.

d Do not shake cartridges after opening the package, as they may leak.
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Remove the ink cartridge from its package and then remove the cap from the bottom of the cartridge.

Note:
Do not touch the sections shown in the illustration. Doing so may prevent normal operation and printing.

Important:
Do not touch the flat white cable connected to the ink cartridge holder.

Note:
A Iftheink cartridge holder does not move to the ink cartridge replacement position, follow the instruction below.
Home > Setup > Maintenance > Ink Cartridge Replacement

4 Do not move the ink cartridge holder by hand; otherwise, you may damage the product.
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Push the tab to unlock the ink cartridge holder and then remove the cartridge diagonally.

Note:
The illustration shows replacement of the cartridge on the far left. Replace the cartridge appropriate to your
situation.

n Puttheink cartridge head first into the ink cartridge holder. Then push the bottom of the cartridge down until it
clicks into place.
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Put the cap back on to the removed cartridge’s ink supply port. Dispose of the used cartridge properly.

Follow the on-screen instruction.

Note:

Q  TheO light continues to flash while the product is charging ink. Do not turn off the product during ink charging. If the
ink charging is incomplete, you may not be able to print.

d Do not insert CD/DVD tray until ink charging complete.
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Maintaining Your Product and Software

Checking the Print Head Nozzles

If you find that the printout is unexpectedly faint or that dots are missing, you may be able to identify the problem by
checking the print head nozzles.

You can check the print head nozzles from your computer by using the Nozzle Check utility or from the product by
using the buttons.

Using the Nozzle Check utility for Windows
Follow the steps below to use the Nozzle Check utility.

Make sure that no warnings or errors are displayed on the LCD screen, the CD/DVD tray is removed, and the
output tray is ejected.

Make sure that A4-size paper is loaded in the cassette 2.

Right-click the product icon on the taskbar, then select Nozzle Check.

If the product icon does not appear, refer to the following section to add the icon.
= “From the shortcut icon on the taskbar” on page 45

n Follow the on-screen instructions.

Using the Nozzle Check utility for Mac OS X

Follow the steps below to use the Nozzle Check utility.

Make sure that no warnings or errors are displayed on the LCD screen, the CD/DVD tray is removed, and the
output tray is ejected.

Make sure that A4-size paper is loaded in the cassette 2.

Access the Epson Printer Utility 4.
= “Accessing the printer driver for Mac OS X” on page 45

Click the Nozzle Check icon.

Follow the on-screen instructions.

BN EaN A
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Using the control panel

Follow the steps below to check the print head nozzles using the product control panel.

Bl BN AN

Make sure that no warnings or errors are indicated in the control panel.

Make sure that A4-size paper is loaded in the paper cassette.

Enter Setup mode from the Home menu.

Select Maintenance.

Select Nozzle Check.

Press & to print the nozzle check pattern.
Below are two sample nozzle check patterns.

Compare the quality of the printed check page with the sample shown below. If there are no print quality
problems, such as gaps or missing segments in the test lines, the print head is fine.

If any segment of the printed lines is missing, as shown below, this could mean a clogged ink nozzle or a
misaligned print head.

= “Cleaning the Print Head” on page 119
= “Aligning the Print Head” on page 121

Cleaning the Print Head

If you find that the printout is unexpectedly faint or that dots are missing, you may be able to solve these problems by
cleaning the print head, which ensures that the nozzles are delivering ink properly.

You can clean the print head from your computer using the Head Cleaning utility in the printer driver or from the
product by using the buttons.

119



User’s Guide

Maintaining Your Product and Software

n Important:
[ Do not turn off the product during head cleaning. If the head cleaning is incomplete, you may not be able to

print.

4 Do not insert the CD/DVD tray until head cleaning is complete.

Note:
A Do not open the scanner unit during head cleaning.

A Use the Nozzle Check utility first to confirm that the print head needs to be cleaned. This saves ink.
A To maintain print quality, we recommend printing a few pages on a regular basis.
0

Because print head cleaning uses some ink from all cartridges, clean the print head only if quality declines; for example,
if the printout is blurry or the color is incorrect or missing.

d  When ink is low you may not be able to clean the print head. When ink is expended you cannot clean the print head.
Replace the appropriate ink cartridge first.

Note only for products with fax function:

If print quality has not improved after repeating this procedure about 2 times, leave the product on and wait for at least six
hours. Then run the nozzle check again and repeat the head cleaning if necessary. If print quality has still not improved,
contact Epson support.

Note only for products without fax function:

If print quality has not improved after repeating this procedure about 2 times, turn the product off and wait for at least six
hours. Then run the nozzle check again and repeat the head cleaning if necessary. If print quality has still not improved,
contact Epson support.

Using the Head Cleaning utility for Windows
Follow the steps below to clean the print head using the Head Cleaning utility.

Make sure that no warnings or errors are displayed on the LCD screen, the CD/DVD tray is removed, and the
output tray is ejected.

Right-click the product icon on the taskbar, then select Head Cleaning.

If the product icon does not appear, refer to the following section to add the icon.
= “From the shortcut icon on the taskbar” on page 45

Follow the on-screen instructions.

Using the Head Cleaning utility for Mac OS X
Follow the steps below to clean the print head using the Head Cleaning utility.

1 Make sure that no warnings or errors are displayed on the LCD screen, the CD/DVD tray is removed, and the
output tray is ejected.
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Access the Epson Printer Utility 4.
= “Accessing the printer driver for Mac OS X” on page 45

Click the Head Cleaning icon.

Follow the on-screen instructions.

S

Using the control panel
Follow the steps below to clean the print head using the product control panel.

Make sure that no warnings or errors are indicated in the control panel.

Enter Setup mode from the Home menu.

Select Maintenance.

n Select Head Cleaning.

Press < to clean the print head.

Aligning the Print Head

If you notice a misalignment of vertical lines or horizontal banding, you may be able to solve this problem by using the
Print Head Alignment utility in your printer driver or by using the product buttons.

Refer to the appropriate section below.

Note:
Do not press @ to cancel printing while printing a test pattern with the Print Head Alignment utility.

Using the Print Head Alignment utility for Windows
Follow the steps below to align the print head using the Print Head Alignment utility.

1 Make sure that no warnings or errors are displayed on the LCD screen, the CD/DVD tray is removed, and the
output tray is ejected.

Make sure A4-size paper is loaded in the cassette 2.
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Right-click the product icon on the taskbar, then select Print Head Alignment.

If the product icon does not appear, refer to the following section to add the icon.
= “From the shortcut icon on the taskbar” on page 45

n Follow the on-screen instructions to align the print head.

Using the Print Head Alignment utility for Mac OS X
Follow the steps below to align the print head using the Print Head Alignment utility.

Make sure that no warnings or errors are displayed on the LCD screen, the CD/DVD tray is removed, and the
output tray is ejected.

Make sure A4-size paper is loaded in the cassette 2.

Access the Epson Printer Utility 4.
= “Accessing the printer driver for Mac OS X” on page 45

Click the Print Head Alignment icon.

Follow the on-screen instructions to align the print head.

BN AN A

Using the control panel
Follow the steps below to align the print head using the product control panel.

Make sure that no warnings or errors are indicated in the control panel.
Make sure that A4-size paper is loaded in the paper cassette.

Enter Setup mode from the Home menu.

Select Maintenance.

Select Print Head Alignment.

Press & to print the patterns.

Bl BN AN
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Find the most solid pattern in each of #1 to #4 groups.

| | m m
1 3 4

E Enter the pattern number for the most solid pattern in #1 group.

#1

E Repeat step 8 for the other groups (#2 to #4).

Finish aligning the print head.

Setting/Changing Time and Region

Follow the steps below to set the time and region using the product control panel.

Note:
This function is only available for fax capable models.

Enter Setup mode from the Home menu.

Select Basic Setup.

Select Date/Time.

Select the date format.

Set the date.

Select the time format.

Set the time.

~goog~RoEoN -

Note:
To select daylight saving time, set Daylight Saving Time to On.

Select Country/Region.
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E Select the region.
Select Yes.

Note:
When the power is left off for an extended period of time, the clock may be reset. Check the clock when you turn the power
back on.

Saving Power

Note only for products with fax function:
A The LCD screen turns black if no operations are performed for a set period.

A The automatic function to turn off the product is not available.

Note only for products without fax function:
The product enters sleep mode or turns off automatically if no operations are performed for a set period.

You can adjust the time before power management is applied. Any increase will affect the product’s energy efficiency.
Please consider the environment before making any change.

Follow the steps below to adjust the time.

For Windows

Access the printer settings.
= “Accessing the printer driver for Windows” on page 44

Click the Maintenance tab, and then click the Printer and Option Information button.
Select Off, 30 minutes, 1 hour, 2 hours, 4 hours, 8 hours, or 12 hours as the Power Off Timer setting.

n Select 3 minutes, 5 minutes, 10 minutes, or 15 minutes as the Sleep Timer setting.

Click the OK button.

For Mac OS X

1 Access the Epson Printer Utility 4.
= “Accessing the printer driver for Mac OS X” on page 45
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Click the Printer Settings button. The Printer Settings screen appears.

Select Off, 30 minutes, 1 hour, 2 hours, 4 hours, 8 hours, or 12 hours as the Power Off Timer setting.

Select 3 minutes, 5 minutes, 10 minutes, or 15 minutes as the Sleep Timer setting.

Click the Apply button.

BN AN

Using the control panel

Enter Setup mode from the Home menu.
Select Printer Setup.

Select Power Off Timer.

Select Off, 30 minutes, 1h, 2h, 4h, 8h, or 12h.
Select Sleep Timer.

Select 3 minutes, 5 minutes, 10 minutes, or 15 minutes.

BB ENR

Cleaning the Product

Cleaning the exterior of the product

To keep your product operating at its best, clean it thoroughly several times a year by using the following instructions.

n Important:

Never use alcohol or thinner to clean the product. These chemicals can damage the product.

Note only for products with fax function:
Close the rear paper feed slot cover and the ADF input tray when you are not using the product to protect the product from
dust.

Note only for products without fax function:
Close the rear paper feed slot cover and the output tray when you are not using the product to protect the product from
dust.
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d  Use a soft, dry, clean cloth to clean the touch panel. Do not use liquid or chemical cleaners.

4 Use a soft, dry, clean cloth to clean the surface of the scanner glass.
If straight lines appear in the printout or the scanned data, clean the left side of the scanner glass carefully.

[ If the glass surface is stained with grease or some other hard-to-remove material, use a small amount of glass
cleaner and a soft cloth to remove it. Wipe off all remaining liquid.

(d  Open the ADF cover and use a soft, dry, clean cloth to clean the roller and the interior of the ADF (only for
products with ADF function).

S

[ Do not press the surface of the scanner glass with any force.

[ Becareful notto scratch or damage the surface of the scanner glass, and do not use ahard or abrasive brush to clean
it. A damaged glass surface can decrease the scan quality.
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[ Remove the document mat as shown in the illustration (only for products with ADF function).

[ Use a soft, dry, clean cloth to clean the inside of the document mat (only for products with ADF function).

Cleaning the interior of the product

To keep your print results at their best, clean the roller inside by using the following procedure.

Be careful not to touch the parts inside the product.

n Important:
[ Be careful to keep water away from the electronic components.

A Do not spray the inside of the product with lubricants.

A Unsuitable oils can damage the mechanism. Contact your dealer or a qualified service person if lubrication is
needed.

Make sure that no warnings or errors are displayed on the LCD screen, the CD/DVD tray is removed, and the
output tray is ejected.

Load several sheets of A4-size plain paper in the cassette 2.
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Enter Copy mode from the Home menu.
n Press ® to make a copy without placing a document on the scanner glass.

Repeat step 4 until the paper is not smeared with ink.

Transporting the Product

If you move the product some distance, you need to prepare it for transportation in its original box or one of a similar
size.

n Important:
[ When storing or transporting the product, avoid tilting it, placing it vertically, or turning it upside down;

otherwise ink may leak.

A Leave the ink cartridges installed. Removing the cartridges can dry out the print head and may prevent the
product from printing.

Plug in the product and turn it on. Wait until the ink cartridge holder returns to the home position.

Turn off the product and unplug its power cord.

n Disconnect all other cables from the product.
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Remove all paper from the rear paper feed slot.

E Close the rear paper feed slot cover, the output tray, the ADF input tray, and the ADF output tray extension.
Then lower the control panel to store.

Remove all paper from the paper cassette and re-insert the cassette into the product.

E Repack the product in its box, using the protective materials that came with it.

n Important:

When storing this product in a box, place it so that the control panel does not get damaged.

Note:
[ Keep the product level during transport.

[ Be sure to remove the protective materials from the product before using it again.

Checking and Installing Your Software

Checking the software installed on your computer

To use the functions described in this User’s Guide, you need to install the following software.
4 Epson Driver and Utilities

4 Epson Easy Photo Print
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[  Epson Print CD
4 Epson Event Manager

Follow the steps below to check that the software is installed on your computer.

For Windows
Windows 7 and Vista: Click the start button and select Control Panel.

Windows XP: Click Start and select Control Panel.

Windows 7 and Vista: Click Uninstall a program from the Programs category.

Windows XP: Double-click the Add or Remove Programs icon.

Check the list of currently installed programs.

For Mac OS X

Double-click Macintosh HD.

Double-click the Epson Software folder in the Applications folder and check the contents.

Note:
[ The Applications folder contains software provided by third parties.

A To check that the printer driver is installed, click System Preferences on the Apple menu and then click Print & Scan
(for Mac OS X 10.7) or Print & Fax (for Mac OS X 10.6 or 10.5). Then locate your product in the Printers list box.

Installing the software

Insert the product software disk that came with your product and select the software you want to install on the Software
Select screen.

Uninstalling Your Software

You may need to uninstall and then reinstall your software to solve certain problems or if you upgrade your operating
system.

See the following section for information on determining what applications are installed.
= “Checking the software installed on your computer” on page 129
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For Windows

Note:

[  For Windows 7 and Vista, you need an administrator account and password if you log on as a standard user.

[  For Windows XP, you must log on to a Computer Administrator account.

el Bl

B

Turn off the product.

Disconnect the product’s interface cable from your computer.

Do one of the following.

Windows 7 and Vista: Click the start button and select Control Panel.
Windows XP: Click Start and select Control Panel.

Do one of the following.

Windows 7 and Vista: Click Uninstall a program from the Programs category.

Windows XP: Double-click the Add or Remove Programs icon.

Select the software you want to uninstall such as your product’s driver and the application from the list
displayed.

Do one of the following.
Windows 7: Click Uninstall/Change or Uninstall.

Windows Vista: Click Uninstall/Change or Uninstall, and then click Continue in the User Account Control
window.

Windows XP: Click Change/Remove or Remove.

Note:
If you chose to uninstall your product’s printer driver in step 5, select the icon for your product and then click
OK.

When the confirmation window appears, click Yes or Next.

Follow the on-screen instructions.

In some cases, a message may appear to prompt you to restart your computer. If so, make sure I want to restart my
computer now is selected and click Finish.
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For Mac OS X

Note:

[  To uninstall your software you need to download the Uninstaller.
Access the site at:
http://www.epson.com
Next, select the support section of your local Epson Web site.

d  To uninstall applications, you must log on to a Computer Administrator account.
You cannot uninstall programs if you log on as a limited account user.

A Depending on the application, the Installer may be separated from the Uninstaller.

Quit all running applications.

Double-click the Uninstaller icon in your Mac OS X hard drive.

Select the check boxes for the software you want to uninstall, such as the printer driver and the application, from
the list displayed.

n Click Uninstall.

Follow the on-screen instructions.

If you cannot find the software you want to uninstall in the Uninstaller window, double-click the Applications folder
in your Mac OS X hard drive, select the application you want to uninstall, and then drag it to the Trash icon.

Note:
Ifyou uninstall the printer driver and the name of your product remains in the Print & Scan (for Mac OS X 10.7) or Print &
Fax (for Mac OS X 10.6 or 10.5) window, select the name of your product and click the - remove button.
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Transferring Data Using an External Storage
Device

You can use the product’s memory card slots or external USB port to copy files to a computer connected to the product.
You can also use it to copy files on your computer to the storage device.

Precautions on Storage Devices

Keep the following in mind when copying files between your storage device and computer:

4 Check the documentation that came with your storage device and any adapter you may be using for any handling
guidelines.

4 Do not copy files to a storage device while you are printing from your storage device.

[ The product display does not update information about your storage device after you copy files to it or delete files
from it. To update the information displayed, eject and reload the storage device.

4 Do not eject your memory card or turn off the product while the memory card light is flashing or you may lose
data.

Copying Files Between a Storage Device and Your
Computer

Copying files to your computer

Make sure the product is turned on and a storage device is inserted or connected.
2 Windows 7 and Vista:
Click the start button and select Computer.

Windows XP:
Click Start and select My Computer.

Mac OS X: o
The removable disk icon (%hf) appears on your desktop automatically.

Double-click the removable disk icon, then select the folder in which your files are saved.

Note:
Ifyou have set a volume label, it is displayed as the drive name. If you have not set the volume label, “removable disk”
is displayed as the drive name on Windows XP.
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Select the files you want to copy and drag them to a folder on your computer’s hard drive.

n Important:

For Mac OS X users
When you remove the storage device, always drag the removable disk icon on your desktop into the trash before
you remove the storage device or you may lose data on the device.

Saving files to a storage device

Before inserting your memory card, make sure the write-protect switch is set to allow writing to the memory card.

Note:
After copying a file to a memory card from a Macintosh computer, an older digital camera may not be able to read the
memory card.

Make sure the product is turned on and a storage device is inserted or connected.
Windows 7 and Vista:
Click the start button and select Computer.

Windows XP:
Click Start and select My Computer.

Mac OS X: -
The removable disk icon (H) appears on your desktop automatically.

Double-click the removable disk icon, then select the folder in which you want to save your files.

Note:
Ifyou have set a volume label, it is displayed as the drive name. If you have not set the volume label, “removable disk”
is displayed as the drive name on Windows XP.

Select the folder on your computer’s hard drive that contains the files you want to copy. Then select the files and
drag them to the folder on your storage device.

Important:

For Mac OS X users

When you remove the storage device, always drag the removable disk icon on your desktop into the trash before
you remove the storage device or you may lose data on it.

134



User’s Guide

Error Indicators

Error Indicators

Error Messages on the Control Panel

This section describes the meaning of messages displayed on the LCD screen.

Error Messages Solutions
Paper jam = See “Paper Jams” on page 139
Paper out = See “Loading Paper” on page 24

Photos not recognized. Place the photos correctly on the
scanner glass.

= See “Scanner glass” on page 36

Printer error. Turn the power off and on again. For details,
see your documentation.

Turn the product off and then back on. Make sure that no paper is
stillinthe product. Ifthe error message stillappears, contact Epson
support.

Communication error. Check if a computer is connected.

Make sure the computer is connected correctly. If the error
messages still appears, make sure that scanning software is
installed on your computer and that the software settings are
correct.

A printer’s ink pad is nearing the end of its service life.
Please contact Epson Support.

Press & to resume printing. The message will be displayed until
theink padis replaced. Contact Epson support to replace ink pads
before the end of their service life. When the ink pads are
saturated, the printer stops and Epson support is required to
continue printing.

A printer’s ink pad is at the end of its service life. Please
contact Epson Support.

Contact Epson support to replace ink pads.

Memory card or external device not recognized.

Make sure memory card or external device has been inserted
correctly.

No dial tone detected. Run Check Fax Connection under
Fax Settings in Setup menu.

Make sure the phone cable is connected correctly and the phone
line works.

= See “Connecting to a Phone Line” on page 85

If you connected the product to a PBX (Private Branch Exchange)
phoneline or Terminal Adapter, turn off the Dial Tone Detection.
Select Fax Settings > Communication > Dial Tone Detection >
Off.

Combination of IP address and subnet mask is invalid. See
your documentation.

Refer the online Network Guide.

Recovery Mode

The firmware update has failed. You will need to re-attempt the
firmware update. Ready a USB cable and visit your local Epson
website for further instructions.
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Troubleshooting for Printing/Copying

Diagnosing the Problem

Troubleshooting product problems is best handled in two steps: first diagnose the problem, then applylikely solutions
until the problem is fixed.

The information that you need to diagnose and solve most common problems is provided by online problem solving,
the control panel, or the status monitor. Refer to the appropriate section below.

If you have a specific problem relating to print quality, a printing problem not related to print quality, or a paper
feeding problem, or if the product does not print at all, refer to the appropriate section.

To solve a problem, you may need to cancel printing.
= “Canceling Printing” on page 49

Checking product status

If a problem occurs while printing, an error message will appear in the status monitor window.
If an error message appears indicating the product’s ink pads are nearing the end of their service life, contact Epson

support to replace them. The message will be displayed at regular intervals until the ink pads are replaced. When the
product’s ink pads are saturated, the product stops and Epson support is required to continue printing.

For Windows

There are two ways to access EPSON Status Monitor 3:
4 Double-click the product shortcut icon on your Windows taskbar. To add a shortcut icon to the taskbar, see the
following section:

= “From the shortcut icon on the taskbar” on page 45

[ Open the printer driver, click the Maintenance tab, then click the EPSON Status Monitor 3 button.
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When you access EPSON Status Monitor 3, the following window appears:

LT EPSON Status Moniter 3 : EPSON 300000 ==
EPSON =
Itis ready to print. =
Technical Support
Ink Levels
Elack Light Cyan Magenta Cyan elow Light Magenta
XK, XN, XAXX XXX, XXX XXX
Information
Print Queue oK Buy Epson Ink |

Note:
IfEPSON Status Monitor 3 does not appear, access the printer driver and click the Maintenance tab and then the Extended
Settings button. In the Extended Settings window, check the Enable EPSON Status Monitor 3 check box.

EPSON Status Monitor 3 provides the following information:
1 Current Status:
Iftheinkislow or expended, the How to button appears in the EPSON Status Monitor 3 window. Clicking How to

displays ink cartridge replacement instructions.

d Ink Levels:
EPSON Status Monitor 3 provides a graphic display of the ink cartridge status.

[ Information:
You can view information about the installed ink cartridges by clicking Information.

(1 Technical Support:
Click Technical Support to access the Epson technical support website.

[  Print Queue:
You can view Windows Spooler by clicking Print Queue.

For Mac OS X

Follow these steps to access EPSON Status Monitor.

1 Access the Epson Printer Utility 4.
= “Accessing the printer driver for Mac OS X” on page 45
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Click the EPSON Status Monitor icon. The EPSON Status Monitor appears.

8nn Epson Printer Utility 4

G

Buy Epson Ink

EPSON epson xxxxx

% EPSON Status Monitor

Ink Levels
wlasu Light Cyas Magets Lyar Fellsw Light Magerria
b 2000 00 200K 00 00
Information |

| Update | [ OK

You can also use this utility to check the ink cartridge status before printing. EPSON Status Monitor displays the ink
cartridge status at the time it was opened. To update the ink cartridge status, click Update.

When ink islow or expended, a How to button appears. Click How to,and EPSON Status Monitor will lead you step by
step through the ink cartridge replacement procedure.

aon Epson Printer Utility 4

&

Buy Epson Ink.

EPSON Eepsonxxxxx

Status description

Replace Cartridge
Phote Black: i

Actions to take

Epson recommends the genuine Epson cartridges listed above, Click [How ta] for
ink cartridge replacement instructions.

| Howto... Continue I[ Cancel ]

138



User’s Guide

Troubleshooting for Printing/Copying

Paper Jams

Never touch the buttons on the control panel while your hand is inside the product.

Note:
0 Cancel the print job if prompted by a message from the LCD screen or the printer driver.

0 After you have removed the jammed paper, press the button indicated in the LCD screen.

Removing jammed paper from the rear cover

Pull out the rear cover and carefully remove the jammed paper.
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n Reattach the rear cover.

Removing jammed paper from inside the product

Carefully remove the jammed paper.

Important:
Do not touch the flat white cable connected to the ink cartridge holder.
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Close the scanner unit slowly.

Removing jammed paper from the paper cassette

Pull out the paper cassette. Then carefully remove the jammed paper.

Remove the jammed paper from the cassette.

Align the edges of the paper.

*giv

n Keep the cassette flat and slowly and carefully reinsert it all the way into the product.

Removing jammed paper from the Automatic Document Feeder
(ADF)

The availability of this feature varies by product.
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Remove the stack of paper from the ADF input tray.

Open the ADF cover. Then carefully remove the jammed paper.

g Important:
Make sure you open the ADF cover before removing jammed paper. If you do not open the cover, the product

may be damaged.

Open the document cover.

n Remove the document mat.
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Carefully remove the jammed paper.

E Reattach the document mat and close the document cover.

Open the Automatic Document Feeder (ADF).

E Close the Automatic Document Feeder (ADF).

Preventing paper jams

If your paper jams frequently, check the following.

4 The paper is smooth, not curled or wrinkled.

d  You are using high-quality paper.

[ The printable side of the paper is face down in the paper cassette.

(4 The printable side of the paper is face up in the rear paper feed slot.
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[ The paper stack was fanned before loading.

4 For plain paper, do not load paper above the line just under the ¥ or z== arrow mark inside the edge guide.
For Epson special media, make sure the number of sheets is less than the limit specified for the media.
= “Selecting Paper” on page 20

[ The edge guides are snug against the edges of the paper.

[ The productis on aflat, stable surface that extends beyond the base in all directions. The product will not operate
properly if it is tilted.

Reprinting after a paper jam (for Windows only)

Afteryou cancel the print job because of a paper jam, you can reprint it without reprinting pages that have already been
printed.

Solve the paper jam.
= “Paper Jams” on page 139

Access the printer settings.
= “Accessing the printer driver for Windows” on page 44

Select the Print Preview check box in the Main or Advanced window of your printer driver.
Make the settings that you want to use to print.
Click OK to close the printer settings window, and then print your file. Print Preview window opens.

Selecta page thathas already been printed in the page listbox on the left side, and then select Remove Page from
the Print Options menu. Repeat this step for all the pages that have already been printed.

Click Print on the Print Preview window.

NMBEBEBeEANER

Print Quality Help

If you are having print quality problems, then compare it with the illustrations below. Click the caption under the
illustration that best resembles your prints.

enthalten alle
| Aufdruck. W

1 5008 "Regel

Good sample Good sample
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= “Horizontal banding” on page 145 = “Vertical banding or misalignment” on page 146

= “Horizontal banding” on page 145 = “Vertical banding or misalignment” on page 146

= “Incorrect or missing colors” on page 146 = “Blurry or smeared print” on page 146

Horizontal banding

(4  Make sure the printable side (the whiter or glossier side) of the paper is face up in the rear paper feed slot.
(4 Make sure the printable side (the whiter or glossier side) of the paper is face down in the paper cassette.

[ Run the Head Cleaning utility to clear any clogged ink nozzles.
= “Cleaning the Print Head” on page 119

[ For best results, use up ink cartridge within six months of opening the package.

[ Try to use genuine Epson ink cartridges.

[ Make sure the paper type selected in the LCD menu or printer driver is appropriate for the type of paper loaded in
the product.

= “Selecting Paper” on page 20

d If banding appears at intervals of 2.5 cm, run the Print Head Alignment utility.
= “Aligning the Print Head” on page 121

4 Ifamoire (cross-hatch) pattern appears on your copy, change the Reduce/Enlarge setting in the LCD menu or
shift the position of your original.

d Ifthere is problem with copy quality, clean the exterior of the product.
= “Cleaning the exterior of the product” on page 125
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Vertical banding or misalignment

[ Make sure the printable side (the whiter or glossier side) of the paper is face up in the rear paper feed slot.
[ Make sure the printable side (the whiter or glossier side) of the paper is face down in the paper cassette.

d Run the Head Cleaning utility to clear any clogged ink nozzles.
= “Cleaning the Print Head” on page 119

(4 Run the Print Head Alignment utility.
= “Aligning the Print Head” on page 121

d For Windows, clear the High Speed check box from the Advanced window in your printer driver. See the online
help for details.
For Mac OS X, select Off from the High Speed Printing. To display the High Speed Printing, click through the
following menus: System Preferences, Print & Scan (for Mac OS X 10.7) or Print & Fax (for Mac OS X 10.6 or
10.5), your product (in the Printers list box), Options & Supplies, and then Driver.

1 Make sure the paper type selected in the LCD menu or printer driver is appropriate for the type of paper loaded in
the product.
= “Selecting Paper” on page 20

(4 If there is problem with copy quality, clean the exterior of the product.
= “Cleaning the exterior of the product” on page 125

Incorrect or missing colors

[ For Windows, clear the Grayscale setting in the Advanced window in your printer driver.
For Mac OS X, clear the Grayscale setting in Print Settings in the Print dialog box in your printer driver.
See the online help for details.

[ Adjust the color settings in your application or in your printer driver settings.
For Windows, check the Advanced window.
For Mac OS X, check the Color Options dialog box from the Print dialog box.
See the online help for details.

[ Run the Head Cleaning utility to clear any clogged ink nozzles.
= “Cleaning the Print Head” on page 119

4 Ifyouhavejustreplaced anink cartridge, make sure the date on the box. If you have not used the product for along
time, Epson recommends replacing the ink cartridges.

= “Replacing an ink cartridge” on page 114

[ Try to use genuine Epson ink cartridges and paper recommended by Epson.

Blurry or smeared print

4 Try to use genuine Epson ink cartridges and paper recommended by Epson.

(4 Makesure the productis onaflat, stable surface that extends beyond the base in all directions. The product will not
operate properly if it is tilted.
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[ Make sure your paper is not damaged, dirty, or too old.

[d Make sure your paper is dry and the printable side (the whiter or glossier side) is face up in the rear paper feed
slot.

(4 Make sure your paper is dry and the printable side (the whiter or glossier side) is face down in the paper cassette.
(4 If the paper is curled toward the printable side, flatten it or curl it slightly in the opposite direction.
[ Make sure the paper type selected in the LCD menu or printer driver is appropriate for the type of paper loaded in
the product.
= “Selecting Paper” on page 20

[d Remove each sheet from the output tray as it is printed.

4 Do not touch or allow anything to come into contact with the printed side of paper with a shiny finish. To handle
your prints, follow the instructions of the paper.

(4 Run the Head Cleaning utility.
= “Cleaning the Print Head” on page 119

(4 Run the Print Head Alignment utility.
= “Aligning the Print Head” on page 121

d Ifthe paper is smeared with ink after printing, clean the interior of the product.
= “Cleaning the interior of the product” on page 127

J Ifyouareprinting high-density data on plain paper using automatic 2-sided printing, lower the Print Density and
choose a longer Increased Ink Drying Time in the Print Density Adjustment window (for Windows) or in the
Two-sided Printing Settings (for Mac OS X) of your printer driver.
= “2-sided printing” on page 53

d Ifthere is problem with copy quality, clean the exterior of the product.
= “Cleaning the exterior of the product” on page 125

Miscellaneous Printout Problems

Incorrect or garbled characters

4 Clear any stalled print jobs.
= “Canceling Printing” on page 49

(d  Turn off the product and computer. Make sure the product’s interface cable is securely plugged in.

[ Uninstall the printer driver, then reinstall it.
= “Uninstalling Your Software” on page 130

Incorrect margins

[ Make sure that the paper is loaded into the rear paper feed slot or the paper cassette correctly.
= “Loading Paper” on page 24
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1 Check the margin settings in your application. Make sure that the margins are within the printable area of the

page.
= “Printable area” on page 166

[ Make sure the printer driver settings are appropriate for the paper size you are using.
For Windows, check the Main window.
For Mac OS X, check the Page Setup dialog box or Print dialog box.

d  Uninstall the printer driver, then reinstall it.
= “Uninstalling Your Software” on page 130

Printout has a slight slant

[ Make sure that the paper is loaded into the rear paper feed slot or the paper cassette correctly.
= “Loading Paper” on page 24

4 IfFast Economy is selected for Paper & Quality Options in the printer driver Advanced window (Windows) or
for Print Quality (Mac OS X) in Print Settings, select another setting.

Size or position of copied image is incorrect
4  Make sure the paper size, layout, or reduce/enlarge setting selected in the control panel matches the paper used.
(d  If the edges of the copy are cropped off, move the original slightly away from the corner.

4 Clean the scanner glass.
= “Cleaning the exterior of the product” on page 125

Inverted image

d For Windows, clear the Mirror Image check box from the Page Layout window of your printer driver, or turn off
the Mirror Image setting in your application.
For Mac OS X, clear the Mirror Image check box in Print Settings in the Print dialog box of your printer driver, or
turn off the Mirror Image setting in your application.
For instructions, see the online help for your printer driver or for your application.

(A Uninstall the printer driver, then reinstall it.
= “Uninstalling Your Software” on page 130

Paper or CD/DVD only prints halfway or is blank

(A Ifthescanner unitis open fora certain period of time, if data reception is interrupted for a certain period of time, or
depending on your computer or the data, the product may stop printing halfway and the paper or CD/DVD may
be ejected. If the scanner unit is open, close it. The product may resume printing, but if it does not, try printing
again.

[ Make sure the printer driver settings are appropriate for the paper size you are using.

For Windows, check the Main window.
For Mac OS X, check the Page Setup dialog box or Print dialog box.
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[ For Windows, check the Skip Blank Page setting by clicking the Extended Settings button on the Maintenance
window of the printer driver.
For Mac OS X, select On from the Skip Blank Page. To display the Skip Blank Page, click through the following
menus: System Preferences, Print & Scan (for Mac OS X 10.7) or Print & Fax (for Mac OS X 10.6 or 10.5), your
product (in the Printers list box), Options & Supplies, and then Driver.

(4 Uninstall the printer driver, then reinstall it.
= “Uninstalling Your Software” on page 130

Printed side is smeared or scuffed

[d If the paper is curled toward the printable side, flatten it or curl it slightly in the opposite direction.

[ For Windows, select Thick paper and envelopes from Printer and Option Information in your printer driver’s
Maintenance window.
For Mac OS X 10.5 or later, select On from the Thick paper and envelopes. To display the Thick paper and
envelopes, click through the following menus: System Preferences, Print & Scan (for Mac OS X 10.7) or Print &
Fax (for Mac OS X 10.6 or 10.5), your product (in the Printers list box, Options & Supplies, and then Driver.

[ Make several copies without placing a document on the scanner glass.
= “Cleaning the interior of the product” on page 127

[ Uninstall the printer driver, then reinstall it.
= “Uninstalling Your Software” on page 130

Printing is too slow

4  Make sure the paper type selected in the LCD menu or printer driver is appropriate for the type of paper loaded in
the product.
= “Selecting Paper” on page 20

d For Windows, clear all customized settings and select Text as the Quality Option from your printer driver’s Main
window.
For Mac OS X, choose alower Print Quality in the Print Settings dialog box from your printer driver’s Print dialog
box.

= “Accessing the printer driver for Windows” on page 44
= “Accessing the printer driver for Mac OS X” on page 45

4 Close any unnecessary applications.

4 Ifyou print continuously for an extended period, the printing may be extremely slow. This is to slow down the
printing speed and prevent the product mechanism from overheating and being damaged. If this happens, you
can continue to print, but we recommend stopping and leaving the product idle for at least 30 minutes with the
power on. (The product does not recover with the power off.) After you restart, the product will print at normal
speed.

d  Uninstall the printer driver, then reinstall it.
= “Uninstalling Your Software” on page 130

If you try all of the methods above and cannot solve the problem, see the following:
= “Increasing the Print Speed (For Windows Only)” on page 153
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Paper Does Not Feed Correctly or the CD/DVD Tray is
Not Inserted Correctly

Paper does not feed
Remove the stack of paper and make sure of the following:
[ You have inserted the paper cassette all the way into the product.

The paper is not curled or creased.

0

[ The paper is not too old. See the instructions that came with the paper for more information.

4 For plain paper, do not load paper above the line just under the ¥ or z== arrow mark inside the edge guide.
For Epson special media, make sure the number of sheets is less than the limit specified for the media.

= “Selecting Paper” on page 20

[ Paper is not jammed inside the product. If it is, remove the jammed paper.
= “Paper Jams” on page 139

[ The ink cartridges are not expended. If a cartridge is expended, replace it.
= “Replacing an ink cartridge” on page 114

[ You have followed any special loading instructions that came with your paper.

Multiple pages feed

4 For plain paper, do not load paper above the line just under the ¥ or === arrow mark inside the edge guide.
For Epson special media, make sure the number of sheets is less than the limit specified for the media.
= “Selecting Paper” on page 20

[  Make sure the edge guides are snug against the edges of the paper.

[ Make sure the paper is not curled or folded. If so, flatten it or curl it slightly toward the opposite side before
loading.

[  Remove the stack of paper and make sure that the paper is not too thin.
= “Paper” on page 164

[ Fan the edges of the stack to separate the sheets, then reload the paper.
d Iftoo many copies of a file are being printed, check the Copies setting in your printer driver as follows, and also
check in your application.

For Windows, check the Copies setting on the Page Layout window.
Mac OS X, check the Copies setting in the Print dialog.
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Paper is improperly loaded

Ifyou have loaded the paper too far into the product, the product cannot feed the paper correctly. Turn the product off
and gently remove the paper. Then turn the product on and reload the paper correctly.

Paper is not ejected fully or is wrinkled

4 Ifthe paper does not eject fully, press & to eject the paper. If the paper is jammed inside the product, remove it by
referring to the following section.
= “Paper Jams” on page 139

4 If the paper is wrinkled when it comes out, it may be damp or too thin. Load a new stack of paper.

Note:
Store any unused paper in its original packaging in a dry area.

The CD/DVD tray is ejected or not inserted correctly when sending a
CD/DVD print job

[ Reinsert the CD/DVD tray correctly.
= “Loading a CD/DVD” on page 30

(d Ifthetrayis ejected when you starta CD/DVD print job, the product is not ready. Wait until you see a message on
your screen asking you to insert the tray. Then reinsert the tray and press <.

The Product Does Not Print

All lights are off

a  Press O to make sure the product is on.
[ Make sure that the power cord is securely plugged in.

[ Make sure that your outlet works and is not controlled by a wall switch or timer.

Lights came on and then went out

The product’s voltage may not match the outlet rating. Turn off the product and unplug it immediately. Then check
the label on the back of the product.

If the voltage does not match, DO NOT PLUG YOUR PRODUCT BACK IN. Contact your dealer.
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Only the power light is on

(A Turn off the product and computer. Make sure the product’s interface cable is securely plugged in.

4 Ifyou are using the USB interface, make sure your cable meets the USB or Hi-Speed USB standards.

d Ifyouare connecting the product to your computer via a USB hub, connect the product to the first-tier hub from
your computer. If the printer driver is still not recognized on your computer, try to directly connect the product to

your computer without the USB hub.

d Ifyouare connecting the product to your computer via a USB hub, make sure the USB hub device is recognized by
your computer.

4 Ifyouaretrying to printalarge image, your computer may not have enough memory. Try reducing the resolution
of your image or printing the image at a smaller size. You may need to install more memory in your computer.

[ Users of Windows can clear any stalled print jobs from the Windows Spooler.
= “Canceling Printing” on page 49

[ Uninstall the printer driver, then reinstall it.
= “Uninstalling Your Software” on page 130

An ink error is indicated after you replace the cartridge

Open the scanner unit.

g

Important:
Do not touch the white flat cable inside the product.

Make sure the ink cartridge holder is at the ink cartridge replacement position.

Note:
Ifthe ink cartridge holder is at the far right position, enter Setup mode from the Home menu, select Maintenance,
and then select Ink Cartridge Replacement.
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Remove and reinsert the ink cartridge and then continue with the ink cartridge installation.

n Close the scanner unit slowly.

Follow the on-screen instruction.

Increasing the Print Speed (For Windows Only)

Print speed may be increased by selecting certain settings in the Extended Settings window when the printing speed is
slow. Click the Extended Settings button on your printer driver’s Maintenance window.

= Printing Preferences |
e —
| 7 Shodcuts | & Main | 5 Advanced | [T PageLayal|| #* Maintenance

EPSOMN Status Monitor 3

Mozde Chedk
R | Head Clezning
E Prirt He:ad Alignment
% Prirter and Qption Information

P —

Version 7.00.00 | ¥ software Update |

[ ok [ cawe |[ Hew |
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The following dialog box appears.

Extended Zettings

| High Speed Copies:
7| Show Prograss Meter

[¥/|Enable EPSOM Skatus Monitor 3
[ 5kip Elank Page

Maonitoring Preferences

| akways spool RAW datatype
| Page Rendering Maode

[ Print as Eitmap

[]change standard Resolution

| Always use the driver's paper source setting

[ Allows &pplications to Perform ICM Calor Matching

Reset DeFauIts| | ok | | Cancel

Select the following check boxes and print speed may be increased.
4 High Speed Copies

4 Always spool RAW datatype

(d Page Rendering Mode

[ Print as Bitmap

For more details on each item, see the online help.

Other Problem

Printing plain papers quietly

When plain paper is selected for the paper type and Standard (Windows) or Normal (Mac OS X) is selected as for
quality in the printer driver, the product prints at high speed. Try choosing Quiet Mode for quieter operation which

will reduce the print speed.

For Windows, select the Quiet Mode check box in the Advanced window of your printer driver.
For Mac OS X, select On from the Quiet Mode. To display the Quiet Mode, click through the following menus: System
Preferences, Print & Scan (for Mac OS X 10.7) or Print & Fax (for Mac OS X 10.6 or 10.5), your product (in the

Printers list box), Options & Supplies, and then Driver.
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Troubleshooting for Scanning

Problems Indicated by Messages on the LCD screen or
Status Light

(4 Make sure the product is connected to your computer properly.

(4 Turn off the product and turn it on again. If the problem is not solved, the product may be malfunctioning, or the
light source in the scanner unit may need to be replaced. Contact your dealer.

[d Make sure the scanning software is fully installed.
See the paper manual for instructions on installing the scanning software.

Problems When Starting a Scan

4 Check the status light and make sure the product is ready to scan.

(4 Make sure your cables are securely connected to the product and a working electrical outlet.
If necessary, test your product’s AC adapter by plugging in another electrical device and turning it on.

(4 Turnoffthe product and computer, and then check the interface cable connection between them to make sure it is
secure.

[ Make sure you select the correct product if a scanner list appears when starting to scan.

Windows:
When you start Epson Scan using the EPSON Scan icon, and the Select Scanner list is displayed, make sure you
select the model of your product.

Mac OS X:
When you start Epson Scan from the Applications folder and the Select Scanner list is displayed, make sure you
select the model of your product.

4 Connectthe productdirectly to the computer’s external USB port or through one USB hub only. The product may
not work properly when connected to the computer through more than one USB hub. If the problem persists, try
connecting the product directly to the computer.

4 Ifmore than one product is connected to your computer, it may not work. Connect only the product you want to
use, and then try scanning again.

4 Ifthescanningsoftware does not work properly, uninstall the software first and then reinstall it as described in the
paper manual.
= “Uninstalling Your Software” on page 130

Using the Automatic Document Feeder (ADF)

4 If the document cover or ADF cover is open, close it and try scanning again.

155



User’s Guide

Troubleshooting for Scanning

[ Make sure you have selected either Office Mode or Professional Mode in Epson Scan.

[ Make sure your cables are securely connected to the product and a working electrical outlet.

Using the button

Note:
Depending on the product, the scanning function may not be available when using the button.

[ Check if you have assigned a program to the button.
= “Epson Event Manager” on page 83

(4 Make sure Epson Scan and Epson Event Manager are installed correctly.

[d Ifyouhaveclicked the Keep Blocking button in the Windows Security Alert window during or after installation of
the Epson Software, unblock Epson Event Manager.
= “How to unblock Epson Event Manager” on page 156

d MacOSX:
Make sure you are logged on as the user who installed the scanning software. Other users must first start Epson
Scanner Monitor in the Applications folder and then press a button to scan.

How to unblock Epson Event Manager

Click Start or the start button, and then point to Control Panel.

Do one of the following.

O Windows 7:
Select System and Security.

(d  Windows Vista:
Select Security.

d Windows XP:
Select Security Center.

Do one of the following.

J  Windows 7 and Windows Vista:
Select Allow a program through Windows Firewall.

d Windows XP:
Select Windows Firewall.

n Do one of the following.

1 Windows 7:
Confirm that the check box for EEventManager Application is selected in the Allowed programs and
features list.
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d Windows Vista:
Click the Exceptions tab, and then confirm that the check box for EEventManager Application is selected
in the Program or port list.

1 Windows XP:
Click the Exceptions tab, and then confirm that the check box for EEventManager Application is selected
in the Programs and Services list.

Click OK.

Using scanning software other than Epson Scan driver

1 Ifyouareusingany TWAIN-compliant programs, such as Adobe Photoshop Elements, make sure that the correct
product is selected as the Scanner or Source setting.

[d If you cannot scan using any TWAIN-compliant scanning programs, such as Adobe Photoshop Elements,

uninstall the TWAIN-compliant scanning program and then reinstall it.
= “Uninstalling Your Software” on page 130

Problems When Feeding Paper

The paper gets dirty

You may need to clean the product.
= “Cleaning the Product” on page 125

Multiple sheets of paper are fed

4 Ifyou load unsupported paper, the product may feed more than one sheet of paper at a time.
= “Automatic Document Feeder (ADF) specifications” on page 168

d  You may need to clean the product.
= “Cleaning the Product” on page 125

The paper jams in the Automatic Document Feeder (ADF)

Remove the jammed paper inside the ADF.
= “Removing jammed paper from the Automatic Document Feeder (ADF)” on page 141

Problems With Scanning Time

4 Computers with Hi-Speed external USB ports can scan faster than those with external USB ports. If youare using a
Hi-Speed external USB port with your product, make sure it meets the system requirements.
= “System Requirements” on page 163
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[d  Scanning at a high resolution takes a long time.

Problems With Scanned Images

Scan quality is unsatisfactory

Scan quality can be improved by changing the current settings or adjusting the scanned image.
= “Image Adjustment Features” on page 63

An image on the back of your original appears in your scanned image

If your original is printed on thin paper, images on the back may be visible to the product and appear in your scanned
image. Try scanning the original with a piece of black paper placed on the back of it. Also make sure the Document
Type and Image Type settings are correct for your original.

Characters are distorted or blurred

d In Office Mode or Home Mode, select the Text Enhancement check box.
4 Adjust the Threshold setting.
Home Mode:
Select Black&White as the Image Type setting, click the Brightness button, and then try adjusting the Threshold

setting.

Office Mode:
Select Black&White as the Image Type setting, and then try adjusting the Threshold setting.

Professional Mode:
Select Black & White as the Image Type setting and click the + (Windows) or» (Mac OS X) button next to Image
Type. Make the appropriate Image Option setting and then try adjusting the Threshold setting.

[ Increase the resolution setting.

Characters are not recognized correctly when converted into editable text
(OCR)

Place the document so that it is straight on the scanner glass. If the document is skewed, it may not be recognized
correctly.

Ripple patterns appear in your scanned image

A ripple or cross-hatch pattern (known as moiré) may appear in a scanned image of a printed document.

e o

=5
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d Rotate your original document.

[d Rotate the scanned image using the application software after scanning.
4 Select the Descreening check box.

[d In Professional Mode, change a resolution setting and scan again.

Uneven color, smears, dots, or straight lines appear in your image

You may need to clean the interior of the product.
= “Cleaning the Product” on page 125

The scanning area or direction is unsatisfactory

The edges of your original are not scanned

d Ifyouare scanning in Full Auto Mode, or using thumbnail preview in Home Mode or Professional Mode, move
the document or photo 6 mm (0.2 inch) away from the horizontal and vertical edges of the scanner glass to avoid

cropping.

[d Ifyouarescanning using the button or using normal preview in Office Mode, Home Mode, or Professional Mode,
move the document or photo about 3 mm (0.12 inch) away from the horizontal and vertical edges of the scanner
glass to avoid cropping.

Multiple documents are scanned into a single file

Position documents at least 20 mm (0.8 inch) apart from each other on the scanner glass.

Cannot scan the area you want

Depending on the documents, you may not be able to scan the area you want. Use normal preview in Office Mode,
Home Mode, or Professional Mode and create marquees on the area you want to scan.
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Cannot scan in the direction you want

Click Configuration, select the Preview tab, and then clear the Auto Photo Orientation check box. Then, place your
documents correctly.

Problems Remain After Trying All Solutions

If you have tried all the solutions and have not solved the problem, initialize the Epson Scan settings.

Click Configuration, select the Other tab, and then click Reset All
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Troubleshooting for Faxing

Cannot send and receive fax

[  Make sure the phone cable is connected correctly and check that the phone line works. You can check the line
status by using the Check Fax Connection function.
= “Connecting to a Phone Line” on page 85

(4 If the fax could not be sent, make sure that the recipient’s fax machine is turned on and working.
(4 Ifthis productis notconnected to a phone and you want to receive faxes automatically, make sure you turn on auto
answer.

= “Receiving Faxes” on page 94

d Ifyou connected the product to a DSL phone line, you must install a DSL filter on the line otherwise you cannot
fax. Contact your DSL provider for the necessary filter.

d Ifyou connected this product to a PBX (Private Branch Exchange) phone line or Terminal Adapter, turn off Dial
Tone Detection.
= “Setup Mode” on page 105

[ Transmission speed may be the cause of the problem. Lower the Fax speed setting.
= “Setup Mode” on page 105

[d  Make sure that ECM is turned on. Color faxes cannot be sent and received when ECM is off.
=» “Setup Mode” on page 105

Quality problems (sending)

4 Clean the scanner glass and Automatic Document Feeder (ADF).
= “Cleaning the exterior of the product” on page 125

[d  If the fax you sent was faint or not clear, change the Resolution (or Quality depending on your model) or
Contrast in the fax settings menu.

= “Setup Mode” on page 105

[ Make sure that ECM is turned on.
= “Setup Mode” on page 105

Quality problems (receiving)

[ Make sure that ECM is turned on.
= “Setup Mode” on page 105
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Answering machine cannot answer voice calls

d  Whenauto answer is turned on and an answering machine is connected to the same phone line as this product, set
the number of rings to answer for receiving faxes to a higher number than the number of rings for the answering
machine.
= “Receiving Faxes” on page 94

Incorrect time

(d  The clock may run fast/slow or may be reset after a power failure, or the power is left off for a long time. Set the
correct time.
= “Setting/Changing Time and Region” on page 123
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Ink Cartridges

You can use the following ink cartridges with this product:

Not all cartridges are available in all regions.

Ink Cartridge Part numbers
XP-750 For Australia / New Zealand
XP-850 XP-850

Black 24/24XL 277/277XL

Cyan 24/24XL 277/277XL

Magenta 24/24XL 277/277XL

Yellow 24/24XL 277/277XL

Light Cyan 24/24XL 277/277XL

Light Magenta 24/24XL 277/277XL

Note:

Color

Black, Cyan, Yellow, Magenta, Light Cyan, Light Magenta

Cartridge life

For best results, use up ink cartridge within six months of opening the package.

Temperature

Storage:

-20to40°C (-4 to 104 °F)
1 month at 40 °C (104 °F)

Freezing:*
-16°C(3.2°F)

* Ink thaws and is usable after approximately 3 hours at 25 °C (77 °F).

System Requirements

For Windows

System

PC Interface

Windows 7 (32-bit, 64-bit), Vista (32-bit, 64-bit), XP SP1 or higher (32-bit), or XP
Professional x64 Edition

Hi-Speed USB
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For Mac OS X

System

PC Interface

Mac OS X 10.5.x, 10.6.x, 10.7.x

Hi-Speed USB

Note:

The UNIX File System (UFS) for Mac OS X is not supported.

Technical Specifications

Note:

Specifications are subject to change without notice.

Printer specifications

Paper path Paper cassette 1 and 2, front entry
Rear paper feed slot™, top entry

Capacity 6.0 mm for cassette 1 and 11.0 mm for cassette 2
0.05 mm to 0.6 mm for rear paper feed slot™1*2

*1 The availability of this feature varies by product.

*2 Some hard paper may not be fed correctly, even if the thickness is within the specified range.

Paper

Note:

[ Since the quality of any particular brand or type of paper may be changed by the manufacturer at any time, Epson
cannot attest to the quality of any non-Epson brand or type of paper. Always test samples of paper stock before
purchasing large quantities or printing large jobs.

A Poor quality paper may reduce print quality and cause paper jams or other problems. If you encounter problems, switch
to a higher grade of paper.

If all the conditions below are met, pre-punched paper with binding holes can be used for this product:

Paper source

Rear paper feed slot

Hole position

Both sides are available.
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Note:

Adjust the size of your file to avoid printing over the binder holes.

Single sheets:

Size

A4210x297 mm
10x15cm (4x6in.)
13x18cm (5% 7in.)
A6 105 x 148 mm
A5148 x210 mm

B5 182 x 257 mm
9%x13cm (3.5%x5in.)
13x20cm (5% 8in.)
20x25cm (8% 10in.)
16:9 wide size (102 x 181 mm)
100 X 148 mm
Letter 8 1/2x 11 in.
Legal 8 1/2 x 14 in.

Paper types

Plain paper or special paper distributed by Epson

Thickness
(for plain paper)

0.08 t0 0.11 mm (0.003 to 0.004 in.)

Weight
(for plain paper)

64 g/m* (17 Ib) to 90 g/m? (24 Ib)

Envelopes:
Size Envelope #104 1/8 X9 1/2in.
Envelope DL 110 x 220 mm
Envelope C6 114 X 162 mm
Paper types Plain paper
Weight 75 g/m? (20 Ib) to 90 g/m? (24 Ib)
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Printable area

Highlighted portions show printable area.

Single sheets:

Product Information

Normal

Borderless

C
Envelopes:
a
Minimum margin
Media type Single sheets Envelopes
A 3.0mm (0.12in.) 3.0mm (0.12in.)
B 3.0mm (0.121in.) 5.0mm (0.20in.)
C 3.0mm (0.12in.) 21.0 mm (0.83in.)
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Note:
Depending on the type of paper, print quality may decline in the top and bottom areas of the print, or the area may be

smeared.

CD/DVD:
— T 4+
/ AN 5
|'llr \"'u
| ® A
III |
\"""-\-.__ __,,--"/ k
A: 18 mm
B: 120 mm
Note:

If you are printing in the following areas of the disc, the disc or the CD/DVD tray may get stained with ink.

Inner hub area 18to 42 mm

Outer periphery area 117 to 120 mm (12-cm CD/DVD)

Scanner specifications

XP-750 XP-850
Scanner type Flatbed color
Photoelectric device cls
Effective pixels 20400 x 56160 pixels at 2400 dpi* 40800 x 56160 pixels at 4800 dpi*
Document size 216 x 297 mm (8.5 x 11.7 inches) A4 or US letter size
Scanning resolution 2400 dpi (main scan) 4800 dpi (main scan)
4800 dpi (sub scan) 4800 dpi (sub scan)
Output resolution 50 to 4800, 7200, and 9600 dpi
(50 to 4800 dpi in 1 dpi increments)
Image data 16 bits per pixel per color internal
8 bits per pixel per color external (maximum)
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Light source

LED

* Scanning area may be restricted if resolution setting is large.

Automatic Document Feeder (ADF) specifications

This option is available only with the XP-850.

Paper input Face-up loading
Paper output Face-down ejection
Paper size A4, Letter, Legal*
Paper types Plain paper

Paper weight 64 to 95 g/m’

Paper capacity

Total thickness of 3 mm, up to about 30 sheets (Letter, A4) 10 sheets (Legal)

* When you scan a 2-sided document using the ADF, the legal size paper is not available.

Fax specifications

This option is available only with the XP-850.

Fax type Walk-up black and white and color fax capability
Support line Household phone line

Speed Up to 33.6 kbps

Resolution Monochrome

Standard: 200 x 100 dpi
Fine: 200 x 200 dpi
Photo: 200 x 200 dpi
Color

Fine: 200 x 200 dpi
Photo: 200 x 200 dpi

Error correction mode

CCITU/ITU Group 3 fax with error correction mode

Speed dial numbers

Up to 60

Page memory

Up to 180 pages (ITU-T No.1 chart)

Redial

2 times (with 1 minute interval)

Interface

RJ-11 Phone Line
RJ-11 Telephone set connection
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Network interface specification

Wi-Fi Standard: IEEE 802.11b/g/n"’
Security: WEP (64/128bit)
WPA-PSK (TKIP/AES)™2
Frequency Band: 2.4 GHz
Communication Mode: Infrastructure mode,
Ad hoc mode
Wi-Fi Direct
Ethernet Standard: IEEE802.3i/u, IEEE802.3az"3

Communication Mode:

Ethernet 100BASE-TX/10BASE-T

*1 Complies with either IEEE 802.11b/g/n or IEEE 802.11b/g depending on location of purchase.
*2 Complies with WPA2 with support for WPA/WPA2 Personal.

*3 The connected device should comply with IEEE802.3az.

Memory card

Note:

The availability of this feature varies by product.

Compatible memory
cards

CompactFlash™
Microdrive™

Memory Stick Duo
Memory Stick PRO Duo
Memory Stick PRO-HG Duo
Memory Stick Micro™2
MagicGate Memory Stick Duo
SDXC

SDHC

SD

MultiMediaCard

MMCplus

MMCmobile™
MMCmicro™2

miniSDHC ™2

miniSD™2

microSDXC"2

microSDHC™2

microSD™2
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Media format DCF

DCF (Design rule for Camera File system) version 1.0 or 2.0 compliant.

All card types standard version compliant.

Voltage Requirements

33v

*1 Maximum current is 500 mA.

*2 Adapter required.

Photo data specifications

File format

JPEG with the Exif Version 2.3 standard

Image size

80 x 80 pixels to 9200 x 9200 pixels

Number of files

Up to 9990

Mechanical

XP-750

Dimensions

Storage (Without protruding parts)
Width: 390 mm (15.4 inches)
Depth: 338 mm (13.3 inches)
Height: 138 mm (5.4 inches)

Storage (Including protruding parts’'"2)
Width: 390 mm (15.4 inches)
Depth: 341 mm (13.4 inches)
Height: 141 mm (5.6 inches)

Printing™

Width: 390 mm (15.4 inches)
Depth: 598 mm (23.5 inches)
Height: 196 mm (7.7 inches)

Weight

Approx. 7.3 kg (16.1 |b) without the ink cartridges and the power cord.

*1*2 See the following illustration for details.

*3 With the output tray extension extended.
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Dimensions

Storage

Width: 390 mm (15.4 inches)
Depth: 339 mm (13.3 inches)
Height: 191 mm (7.5 inches)

Printing*

Width: 438 mm (17.2 inches)
Depth: 598 mm (23.5 inches)
Height: 207 mm (8.1 inches)

Weight

Approx. 8.7 kg (19.2 Ib) without the ink cartridges and the power cord.

* With the output tray extension extended.

Electrical

XP-750

100-120 V Model

220-240 V Model

Input voltage range

90to 132V

198-264 V

Rated frequency range

50to 60 Hz

50to 60 Hz

Input frequency range

49.5t060.5 Hz

49.5t0 60.5 Hz

Rated current

0.7 A

035A

Power consumption

Standalone copying

Approx. 20 W (ISO/IEC24712)

Approx. 20 W (ISO/IEC24712)

Ready mode Approx. 6.5 W Approx. 6.5 W
Sleep mode Approx. 1.8 W Approx. 1.8 W
Power off Approx.0.2 W Approx. 0.4 W

XP-850

100-120 V Model

220-240 V Model

Input voltage range

90to 132V

198-264 V

Rated frequency range

50to 60 Hz

50to 60 Hz

Input frequency range

49.5t060.5 Hz

49.5t060.5 Hz

Rated current

0.7A

035A

Power consumption

Standalone copying

Approx. 21 W (ISO/IEC24712)

Approx. 21 W (ISO/IEC24712)

Ready mode Approx. 7.0 W Approx. 7.0 W
Sleep mode Approx.2.0W Approx.2.0 W
Power off Approx.0.2 W Approx.0.4 W
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Note:
Check the label on the back of the product for its voltage.

Environmental

Temperature Operation:
10 to 35 °C (50 to 95 °F)

Storage:
-20t040°C (-4 to 104 °F)

1 month at 40 °C (104 °F)

Humidity Operation:*
20 to 80% RH

Storage:*
510 85% RH

* Without condensation

Standards and approvals

U.S. model:
Safety UL60950-1
CAN/CSA-C22.2 N0.60950-1
EMC FCC Part 15 Subpart B Class B
CAN/CSA-CEI/IEC CISPR 22 Class B

This equipment contains the following wireless module.
Manufacture: Askey Computer Corporation
Type: WLU6117-D69 (RoHS)

This product conforms to Part 15 of the FCC Rules and RSS-210 of the IC Rules. Epson cannot accept responsibility for
any failure to satisfy the protection requirements resulting from a non-recommended modification of the product.
Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this
device must accept any interference received, including interference that may cause undesired operation of the device.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and away from
windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed outdoors is subject to

licensing.

European model:

Low voltage directive 2006/95/EC EN60950-1

EMC directive 2004/108/EC EN55022 Class B
EN61000-3-2
EN61000-3-3
EN55024
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R&TTE directive 1999/5/EC EN300 328
EN301 489-1
EN301 489-17
TBR21*
EN60950-1

* This only applies to the XP-850.

For European users:
We, Seiko Epson Corporation, hereby declare that the equipment Models, C492A, C491B are in compliance with the
essential requirements and other relevant provisions of Directive 1999/5/EC.

For use only in Ireland, UK, Austria, Germany, Liechtenstein, Switzerland, France, Belgium, Luxemburg,
Netherlands, Italy, Portugal, Spain, Denmark, Finland, Norway, Sweden, Iceland, Cyprus, Greece, Slovenia, Malta,

Bulgaria, Czech, Estonia, Hungary, Latvia, Lithuania, Poland, Romania, and Slovakia.

Only indoor operation is permitted in France.
If used outside of own premises, general authorization is required in Italy.

Epson can not accept responsibility for any failure to satisfy the protection requirements resulting a

non-recommended modification of the products.

Australian model:

EMC AS/NZS CISPR22 Class B

Epson hereby declares that the equipment Model, C492A is in compliance with the essential requirements and other
relevant provisions of AS/NZS4268. Epson cannot accept responsibility for any failure to satisfy the protection
requirements resulting from a non-recommended modification of the product.

Interface

Hi-Speed USB (Device Class for computers)

Hi-Speed USB (for PictBridge compliant devices/Mass storage class for external storage)*

* Epson cannot guarantee the operation of externally connected devices.

External USB device

Devices The maximum capacities

CD-R drive*, DVD-R drive*, Blu-ray CD-ROM / CD-R: 700MB

H *
drive DVD-ROM / DVD-R: 4.7GB
(CD-RW, DVD-RW, DVD+R, DVD+RW and Blu-ray Disc™ are not supported.)
MO drive* 1.3GB
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Hard disk drive* 2TB
USB Flash drive Formatted in FAT, FAT32, or exFAT

* External storage devices that are powered via USB are not recommended. Use only external storage devices with independent AC

power sources.

Photo data file format DCF (Design rule for Camera File system) version 1.0 or 2.0* compliant.

* Photo data stored in digital cameras with built-in memory are not supported.

JPEG with the Exif Version 2.3 standard.
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Where To Get Help

Technical Support Web Site

Epson’s Technical Support Web Site provides help with problems that cannot be solved using the troubleshooting
information in your product documentation. Ifyouhave a Web browser and can connect to the Internet, access the site
at:

http://support.epson.net/
http://www.epson.eu/Support (Europe)

If you need the latest drivers, FAQs, manuals, or other downloadables, access the site at:

http://www.epson.com
http://www.epson.eu/Support (Europe)

Then, select the support section of your local Epson Web site.

Contacting Epson Support

Before Contacting Epson

If your Epson product is not operating properly and you cannot solve the problem using the troubleshooting
information in your product documentation, contact Epson support services for assistance. If Epson support for your
area is not listed below, contact the dealer where you purchased your product.

Epson support will be able to help you much more quickly if you give them the following information:

[ Product serial number
(The serial number label is usually on the back of the product.)

[ Product model

d  Product software version
(Click About, Version Info, or similar button in the product software.)

(4 Brand and model of your computer
d  Your computer operating system name and version

[ Names and versions of the software applications you normally use with your product

Note:

Depending on the product, the dial list data for fax and/or network settings may be stored in the product’s memory. Due to
breakdown or repair of a product, data and/or settings may be lost. Epson shall not be responsible for the loss of any data, for
backing up or recovering data and/or settings even during a warranty period. We recommend that you make your own
backup data or take notes.
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Help for Users in Europe

Check your Pan-European Warranty Document for information on how to contact Epson support.

Help for Users in Australia

Epson Australia wishes to provide you with a high level of customer service. In addition to your product
documentation, we provide the following sources for obtaining information:

Your Dealer

Don’t forget that your dealer can often help identify and resolve problems. The dealer should always be the first call for
advise on problems; they can often solve problems quickly and easily as well as give advise on the next step to take.

Internet URL http://www.epson.com.au

Access the Epson Australia World Wide Web pages. Worth taking your modem here for the occasional surf! The site
provides a download area for drivers, Epson contact points, new product information and technical support (e-mail).

Epson Helpdesk

Epson Helpdesk is provided as a final backup to make sure our clients have access to advice. Operators on the Helpdesk
can aid you in installing, configuring and operating your Epson product. Our Pre-sales Helpdesk staff can provide
literature on new Epson products and advise where the nearest dealer or service agent islocated. Many types of queries
are answered here.
The Helpdesk numbers are:

Phone: 1300 361 054

Fax: (02) 8899 3789

Weencourage you to haveall the relevant information on hand when you ring. The more information you prepare, the
faster we can help solve the problem. This information includes your Epson product documentation, type of
computer, operating system, application programs, and any information you feel is required.
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